### Contents

What’s New in SAS Business Rules Manager 2.2 ................................. ix
Accessibility ................................................................. xi

**PART 1  Getting Started**  1

**Chapter 1 • Introduction to SAS Business Rules Manager**  3
About Decision Management .................................................. 3
About SAS Business Rules Manager ......................................... 3
Exploring the User Interface ................................................. 4
Managing Preferences ...................................................... 7
Viewing Help and Documentation ...................................... 9
Create and Publish Business Rules ................................. 10

**Chapter 2 • Quick Start Tutorial**  11
Tutorial Overview .......................................................... 11
Make the Tutorial Files Available .................................... 12
Sign In ................................................................. 13
Define Data Sources .................................................... 13
Define Business Rule Folders ......................................... 15
Create a Vocabulary, Entities, and Terms .................... 16
Create a Rule Set and Define Business Rules .............. 20
Create and Publish a Rule Flow .................................. 23

**Chapter 3 • Managing Data Tables**  25
About Managing Data Tables ........................................... 25
Adding Tables Using SAS Visual Data Builder ............ 26
Add a Table That Is Registered in Metadata ............ 26
Register and Add New Tables ........................................ 26
Edit Table Properties and View Table Metadata .......... 27
View Table Data ...................................................... 28
Filter Data in the Table View ..................................... 29
Create a New Table Summary ...................................... 30
Add Attachments to a Table ....................................... 31
Add Comments to a Table .......................................... 31
Delete a Table Summary .............................................. 32
Remove a Table ...................................................... 32

**Chapter 4 • Managing Business Rule Folders**  33
About Business Rules Folders ........................................ 33
Create New Top-Level Folders .................................. 33
Create New Folders .................................................. 33
Rename a Folder ....................................................... 34
Move a Folder .......................................................... 34
Delete a Folder .......................................................... 34
### Chapter 5 • Managing Vocabularies ................................................................. 37
- Introduction to Vocabularies, Entities, and Terms ........................................... 37
- Tips for Creating Entities and Terms .......................................................... 38
- Create a Vocabulary ................................................................................... 38
- Create New Entities .................................................................................... 39
- Create New Terms ...................................................................................... 39
- Import Terms from a Data Source ............................................................... 40
- Specify Domain Values .............................................................................. 41
- Edit Existing Vocabularies, Entities, or Terms ............................................. 42
- Delete Vocabularies, Entities, or Terms ....................................................... 42
- Search for Rule Sets by Term ..................................................................... 42

### Chapter 6 • Using Lookup Tables And Functions ........................................... 45
- About Lookup Tables and Functions ......................................................... 45
- Create a New Lookup Table ....................................................................... 46
- Refresh a Lookup Table ........................................................................... 47
- Delete a Lookup Table ............................................................................. 47
- Copy a Lookup Table ............................................................................... 47
- Move a Lookup Table ............................................................................... 47
- Verify Lookup Keys (Lookup Function) ....................................................... 48
- Get Lookup Values (LookupValue Function) ............................................... 48

### Chapter 7 • Managing Rules and Rule Sets ..................................................... 51
- About Rules, Rule Sets, and Expressions .................................................... 52
- How Rules Are Evaluated and Rule-Fired Records ....................................... 53
- Create a New Rule Set ............................................................................... 53
- Defining New Rules in the Rule Set ............................................................. 53
- Validate the Expressions in a Rule Set ......................................................... 66
- Change the Order of Rules in a Rule Set ..................................................... 66
- Copy Rules and Expressions ..................................................................... 67
- Delete Rules and Expressions .................................................................. 68
- Edit the Properties of a Rule ..................................................................... 68
- Edit the Properties of a Rule Set ................................................................. 68
- Display Usage Information for a Rule Set .................................................... 69
- Managing Rule Set Versions ..................................................................... 70
- Add Comments to a Rule Set ..................................................................... 71
- Add Attachments to a Rule Set .................................................................. 71
- Copy a Rule Set ......................................................................................... 72
- Move a Rule Set to a Different Folder ......................................................... 72
- Delete a Rule Set ....................................................................................... 72
- Save a Rule Set ......................................................................................... 73

### Chapter 8 • Creating and Publishing Rule Flows ........................................... 75
- Introduction to Rule Flows ......................................................................... 76
- Simple Rule Flows, Complex Rule Flows, and BY Groups ............................ 76
- Create a Rule Flow Using the Rule Flow Editor .......................................... 76
- Create a Rule Flow by Using Discovery Techniques ..................................... 78
- Open Rule Sets from the Rule Flow Editor ............................................... 80
- Add Attachments to a Rule Flow ................................................................. 80
- Add Comments to a Rule Flow .................................................................. 81
- Change the Order of the Rule Sets ............................................................. 81
- View the Terms Used in a Rule Flow .......................................................... 81
- Managing Versions of a Rule Flow ............................................................. 82
- Rename a Rule Flow .................................................................................. 82
Copy a Rule Flow ................................................................. 82
Move a Rule Flow to a Different Folder ................................. 83
Remove a Rule Set from a Rule Flow .................................. 83
Delete a Rule Flow .............................................................. 83
Testing a Rule Flow ............................................................ 83
Publish a Rule Flow ............................................................ 86
Display Publish Information for Rule Flows ............................ 87
Deploy a Rule Flow as a Stored Process ................................. 87

PART 3  Using SAS Workflow with SAS Business Rules Manager 89

Chapter 9 • Starting a Workflow and Working with Tasks ............... 91
Overview of Using Workflows .............................................. 91
Start a New Workflow ......................................................... 91
Working with Workflow Tasks .............................................. 92

Chapter 10 • Managing Workflows ........................................ 95
Overview of Managing Workflows ...................................... 95
Viewing Workflows ............................................................ 97
Migrate Workflows ............................................................. 97
Set Mappings ................................................................. 97
Working with Workflow Participants .................................... 98
Edit Task Properties .......................................................... 100
Terminate a Workflow ....................................................... 100

PART 4  Appendix  103

Appendix 1 • Rule-Fired Table Fields .................................... 105

Glossary ........................................................................ 107
Index ........................................................................... 111
What’s New in SAS Business Rules Manager 2.2

Overview

SAS Business Rules Manager 2.2 runs on the second maintenance release of SAS 9.4. Major features for this release include the ability to manage versions and support for SAS Workflow. New features and enhancements in this release enable you to perform the following tasks:

- send rule flows through approval workflows and track workflow tasks
- manage versions of rule sets and rule flows
- deploy rule flows as stored processes
- run a wizard to generate and import vocabularies, rule sets, and rule flows from a data table by using the Decision Tree, Scorecard, Market Basket Analysis, or Recency Frequency Monetary discovery technique
- execute rule flows inside the databases by using the SAS In-Database Code Accelerator for Teradata or the SAS In-Database Code Accelerator for Greenplum
- selectively include rule sets in a rule flow
- save rule flow tests and display the results of previous tests
- display the rules that were fired for specific output records
- import vocabularies from an input data table, including domain values
- display the terms and lookup tables that are used in a rule set
- see where rule sets are used in rule flows
- search for rule sets by term
- create libraries and register tables in the SAS Metadata Repository

Manage Workflows and Track Workflow Tasks

You can send rule flows through approval workflows from within SAS Business Rules Manager. You can claim tasks that are defined for the workflows and perform the actions associated with the tasks. Tasks that you have claimed are displayed in the My Tasks category. For more information, see “Overview of Using Workflows” on page 91.
Manage Versions of Rule Sets and Rule Flows

On the Versions pages, you can display detailed information about a version. For rule sets, you can lock versions and add new versions. For rule flows, a new version is created each time you publish a rule flow. See “Managing Rule Set Versions” on page 70 and “Managing Versions of a Rule Flow” on page 82 for more information.

Deploy Rule Flows as Stored Processes

When you save a rule flow as a stored process, the rule flow is made available as a stored process on the SAS Stored Process Server. Other applications can then execute the rule flow and receive and process the results. See “Deploy a Rule Flow as a Stored Process” on page 87 for more information.

New Rule Discovery Wizard

SAS Business Rules Manager now provides a New Discovery wizard that enables you to use analytical techniques to generate and import rule flows from a data table. You can use the Decision Tree, Scorecard, Market Basket, or Recency Frequency Monetary (RFM) technique to generate and import business rule data into the rules database. This wizard generates a vocabulary, as many rule sets as are needed, and a rule flow. See “Create a Rule Flow by Using Discovery Techniques” on page 78 for more information.

Execute Rule Flows inside the Databases

SAS Business Rules Manager 2.2 executes rule flows inside the databases by using the SAS In-Database Code Accelerator for Teradata or the SAS In-Database Code Accelerator for Greenplum when possible. Some complex rule flows cannot be executed inside the database.

Support for Additional Operators

SAS Business Rules Manager now supports the LIKE operator in condition expressions. It also supports leading + (plus) and − (minus) operators in action expressions.
Accessibility

For information about the accessibility of this product, see Accessibility Features of SAS Business Rules Manager 2.2 at support.sas.com.
Part 1

Getting Started

Chapter 1

Introduction to SAS Business Rules Manager ........................................... 3

Chapter 2

Quick Start Tutorial ................................................................................. 11

Chapter 3

Managing Data Tables ............................................................................. 25

Chapter 4

Managing Business Rule Folders ............................................................. 33
Chapter 1
Introduction to SAS Business Rules Manager

About Decision Management

Decision management systems can transform the way businesses make decisions. They enable businesses to use the information they already have to make better decisions—decisions that are based on predictive analytics rather than on past history. Decision management systems automate the process of making decisions, particularly day-to-day operational decisions. They improve the speed, efficiency, and accuracy of routine business processes, in part by reducing the need for human intervention. By automating decisions, organizations in every industry can improve interactions with customers, partners, suppliers, and employees. In addition, organizations that are highly regulated, such as financial services, health care, and insurance, can more easily achieve compliance as a result of repeatable, traceable decisions.

About SAS Business Rules Manager

Business rules capture the logic of business decisions and are one of the core components of decision management systems. Business rules make the decision-making process transparent and adaptable, allowing organizations to respond quickly to new
information about customers and markets. They allow organizations to identify and deal with fraud, avoid unnecessary risk, and find opportunities hidden in customer data.

You can use SAS Business Rules Manager to create a database of business rules, connect those rules together into rules flows, and publish the rule flows for use by other applications. SAS Business Rules Manager provides the following capabilities:

data management
You can manage your list of data tables from within the application. You can create new Base SAS libraries, add and remove tables, view table data and metadata, create and delete table summaries, and associate attachments and comments with tables. The application uses these data tables whenever it needs to access data, such as for rule discovery and rule flow testing.

vocabulary management
A business vocabulary identifies the objects and actors in your business domain. It defines the entities and terms that are the building blocks of business rules. SAS Business Rules Manager enables you to easily create and edit entities and terms. For individual terms, you can create a list of allowable values, which makes creating rules even easier.

business rule authoring
A business rule specifies conditions to be evaluated and action to be taken if those conditions are satisfied. For example, you can create a rule that determines whether a customer has a mortgage. That same rule can then add the outstanding balance of the mortgage to a running total of the customer’s debt. With SAS Business Rules Manager, you define the conditions and actions for each rule. You can use the Expression Editor to create the expressions for the rule.

rule set management
A rule set is a logical collection of rules. A single rule set can have many rules. For example, you might have a rule set that determines a customer’s asset balance and another rule set that determines a customer’s debt level. SAS Business Rules Manager displays rules sets in decision tables. Each row of the decision table defines the conditions and actions for one rule. By using SAS Business Rules Manager, you can easily create new rule sets, reorder the rules in a rule set, add new rules to existing rule sets, and more.

rule flow authoring and publishing
A rule flow is a logical collection of rule sets. A rule flow defines a set of rule sets and the order in which they must be executed. A single rule flow frequently corresponds to a single decision. For example, a rule flow can initially execute the rule set that determines a customer’s asset balance. Next, the rule set that determine a customer’s debt level is executed. Finally, the rule set that assign’s a customer’s loan application status is executed.

SAS Business Rules Manager makes it easy to combine rules sets into a rule flow and to publish those rule flows to the metadata server. After a rule flow has been published, it is available for use by other applications.

---

**Exploring the User Interface**

The SAS Business Rules Manager interface has several category views and several detail tiles that display information about different types of items in the rules database.
The Business Rules Category View

Each of the category views are similar. The following figure shows the Business Rules category view.

Figure 1.1  Business Rules Category View

1. The menu bar provides options for managing preferences, accessing Help resources, and opening recently edited items.

2. The Navigation pane lists the categories of items. Click a category to display the list of items in that category.

3. The Tile pane displays icons for open items. When you open an item, its icon is automatically added to the Tile pane and remains in the Tile pane until you click ⌊ to close the item’s tile.

Use the icons in the View toolbar to switch between the most recently viewed category view and a detail tile. Click ⌈ to return to the previously displayed category view. Click ⌊ to display the most recently viewed detail tile. Click ⌈ at the far right of the Tile pane to maximize the display of the currently opened objects.

To close all open items, click View and select Close All. To open the tiles for all of the minimized items in the tile pane, click View and select Show All.

4. The status bar displays the user ID or display name of the user who is logged on to the metadata server, and alert notices.

5. Alerts are displayed when an action that you take has failed. Click Alerts to view the list of alerts.

6. Panes and tiles can have their own toolbars, so you might see multiple toolbars when the window contains multiple tiles.

7. The category view lists the items that are in the currently selected category. In the category view, you can open and edit any of the items that are in your rules database. See “Control the Appearance of a Category View” on page 7 for information about controlling the display of information in the category view.
The Rule Set Tile

Each of the detail tiles is specific to the type of item. For example, when you open a rule set, SAS Business Rules Manager opens a tile that shows the decision table for that rule set.

Figure 1.2 Rule Set Tile (Decision Table)

1. The Vocabulary pane lists the entities and terms in the vocabulary assigned to the rule set. You use this list to add terms to the decision table.

2. The decision table contains all of the rules that are defined in the rule set. By using the menu in the toolbar above the decision table, you can choose whether you want to display the decision table in a horizontal format or a vertical format. Figure 1.2 shows the decision table in the horizontal format.

   In the horizontal format, each row represents a single rule. Terms are listed across the top of the table. The left side of the table contains the condition expressions, and the right side contains the action expressions.

   In the vertical format, each column represents a single rule. Terms are listed on the left side of the table. The top section of the table contains the condition expressions, and the bottom section contains the action expressions.

3. There are two toolbars in the rule set tile. Each section has its own toolbar.

4. The Rule Details tab contains detailed information about the currently selected rule. The Rule expression field displays the expressions as they are rendered by SAS Business Rules Manager in the published rule flow.
Control the Appearance of a Category View

To change which columns are displayed in a category view, click \[ \text{Modify} \]. SAS Business Rules Manager opens the Manage Columns window. To remove a column from the category view, select the item in the **Displayed columns** list and click \[ \text{Remove} \]. To add a column, select the column in the **Available columns** list and click \[ \text{Add} \]. Click **OK** to save your changes.

To change how columns are sorted in the category view, click \[ \text{Sort} \]. SAS Business Rules Manager opens the **Sort** window. To sort the category view by one or more columns, select those columns in the **Items to sort** list and click \[ \text{Add} \]. SAS Business Rules Manager adds those columns to the **Sort By** list. For each column in the **Sort By** list, select whether you want the column to be sorted in ascending or descending order. The columns are listed in the category view in the order in which they are shown in the **Sort By** list. To change the order of a column, select the column and click \[ \text{Up} \] or \[ \text{Down} \].

Managing Preferences

About Setting Preferences

Preferences provide a way for you to customize the user interface. Preferences for each user are stored in metadata and are retained if your deployment is migrated or reconfigured.

You can set preferences in two ways:

by using the Preferences window
To open the Preferences window, select **File \(\rightarrow\) Preferences**. There are two general categories of preferences: Global and Decision Manager preferences. See “Global Preferences” and “Decision Manager Preferences” on page 8 for more information.

by using SAS Preferences Manager
SAS Preferences Manager is a web application that provides a central facility for users to manage their preferences and settings. See “SAS Preferences Manager” on page 8 for more information.

Global Preferences

Global preferences apply to all SAS web applications that are displayed with the Adobe Flash Player. When you set a global preference, it applies only to the user that you are logged on as.

To set global preferences, select the **Global Preferences** page. The following global preferences are available:

**User locale**
specifies the geographic region whose language and conventions are used in the applications. This setting might also apply to some SAS web applications that are not displayed with the Adobe Flash Player. The default is the browser locale. Locale changes take effect after you log off and log back on.
Note: You can also set the User locale setting by using the SAS Preferences Manager. Select the Regional menu option in SAS Preferences Manager. For more information, see “SAS Preferences Manager” on page 8 and “SAS Preferences Manager” in Chapter 7 of SAS Intelligence Platform: Middle-Tier Administration Guide.

Note: If the user locale that you specify in the preferences is different from the user locale for the SAS Workspace Server, you might receive an error when you try to sign in to the application. You might also receive encoding errors when executing tasks in SAS Business Rules Manager. If you receive an error, change the updated locale back to the original locale.

**Theme**

specifies the collection of colors, graphics, and fonts that appear in the applications. Your site administrator can change the default theme. A theme change might take a few seconds to apply if many items and features are open in the application.

**Invert application colors**

inverts all of the colors in the application window, including both text and graphical elements. You can also temporarily invert or revert the colors for an individual application session by pressing Ctrl+~.

**Override settings for focus indicator**

controls the appearance of the highlighting that surrounds the currently selected field in the SAS Business Rules Manager interface.

### Decision Manager Preferences

Decision Manager preferences apply to SAS Business Rules Manager only. To set these preferences, select Decision Manager ⇒ General.

**Show this number of recent items**

controls the number of items that are listed in the Recent Work menu. To display this menu, select File ⇒ Recent Work.

### SAS Preferences Manager

SAS Preferences Manager is a web application that provides a common mechanism for managing preferences for SAS web applications. The application enables users to manage their preferences and administrators to set default preferences for locale, theme, alert notification, time, date, and currency.

To launch the SAS Preferences Manager, enter the URL `http://host-name:port/SASPreferences` in your browser window. Replace the values for host-name and port based on the location of the configured SAS Web Infrastructure Platform. For more information, see “SAS Preferences Manager” in Chapter 7 of SAS Intelligence Platform: Middle-Tier Administration Guide.

### Change the Delivery Type for Alert Notifications

The default delivery type for notifications is specified in the properties for the SAS Application Infrastructure by using the Configuration Manager plug-in to SAS Management Console. For SAS 9.4, the default delivery type is My alerts portlet.

You can use SAS Preferences Manager to change your default delivery type.

*Note:* A SAS administrator can modify the default notification type for all users. For information about modifying the default delivery type for all users, see “Configuring

To specify the notification delivery preference for an individual user:

1. Enter the URL http://host-name:port/SASPreferences in your browser window to launch the SAS Preferences Manager. Replace the values for host-name and port based on the location of the configured SAS Web Infrastructure Platform.

2. Enter the user ID and password for the user account that you use to access SAS web applications.

3. Select **General** ⇒ **Notifications**.

4. Select a format type for the e-mail notifications. The options are **HTML-formatted e-mail** and **Plain-text e-mail**.

5. Select the notification types from the Available list and click ] to add the selected notification types.

   **TIP** To remove a notification type, select the type from the list and click [x].

6. Click **Apply** to update the notification settings, and click **OK** to save the changes.

For more information, see “SAS Preferences Manager” in Chapter 7 of *SAS Intelligence Platform: Middle-Tier Administration Guide*.

---

**Viewing Help and Documentation**

SAS Business Rules Manager provides the following types of Help and documentation:

**how-to Help**

How-to Help provides quick instructions or tips to help you complete some tasks in the application. To access how-to Help, select **Help** ⇒ **How To**.

**embedded Help**

Embedded Help pop-up menus and tooltips provide brief descriptions of various fields.

To access a Help pop-up menu for a field, click the Help icon ( ) when it appears next to a field. You can also place the mouse pointer over an element in the SAS Business Rules Manager windows to view the associated tooltip.


This document provides detailed information about the concepts and tasks that are related to using SAS Business Rules Manager. This document is available at [http://support.sas.com/documentation/onlinedoc/brm](http://support.sas.com/documentation/onlinedoc/brm).

**SAS Business Rules Manager: Administrator's Guide**

This document contains information about the administration tasks that are required to set up and configure the SAS Business Rules Manager and is available at [http://support.sas.com/documentation/onlinedoc/brm](http://support.sas.com/documentation/onlinedoc/brm).

Additional resources are available from the **Help** menu. To access these resources, select **Help** ⇒ **SAS on the Web**.
Create and Publish Business Rules

To create and publish business rules using SAS Business Rules Manager:

1. Add data tables to your list of data sources.
2. Create business rule folders where you want to save the business rules.
3. Create vocabularies.
4. Create entities and terms.
5. Create rule sets and rules.
6. Create rule flows.
7. (Optional) Test rule flows.
8. Publish rule flows.

After a rule flow has been published, it is available for use by other applications such as SAS Data Integration Studio. These applications map objects in the rules database to objects in the input data. For example, terms are usually mapped to table columns or to data set variables. The output generated when a rule flow is executed is written to a data set. The location of the data set is specified by the application.
Chapter 2
Quick Start Tutorial

Tutorial Overview

The Quick Start tutorial is an introduction to some of the primary features of SAS Business Rules Manager. It also enables you to validate the installation and configuration of SAS Business Rules Manager at your site.

In this tutorial, you create a simple rule flow for loan validation. The rule flow determines whether a loan application is a bad risk based on the loan score, the reason for the application, and other factors. It assigns a value of True if the loan is a bad risk and a value of False if it is not.

With the exception of Step 1, the steps in this tutorial are the same basic steps that are required to build a rules database. In this tutorial, you complete the following steps:

1. Make the tutorial files available on the SAS Application Server.
   
   *Note:* The zip file containing the tutorial files contains data and models for several tutorials, including the Quick Start tutorial.

2. Sign in to SAS Business Rules Manager.
3. Define the data source needed for the tutorial.
4. Define business rule folders.
5. Create a vocabulary and import the terms.
6. Create a rule set and define business rules.
7. Create and publish a rule flow.

---

**Make the Tutorial Files Available**

**About Making the Tutorial Files Available**

The tutorial is designed to use the SAS Metadata Repository. Before you use tables in the SAS Metadata Repository, the tutorial data sets must be on the SAS Application Server. An administrator who has Write access to the server and a valid SASApp user ID and password can put the tables there.

The drive where you extract the tutorial ZIP file must be accessible to the SAS Metadata Repository and to tutorial users. Tutorial users can also extract tutorial ZIP files to their local computers in order to access the other files.

You can define a data library and register the tables in the SAS Metadata Repository using the Data category view in SAS Business Rules Manager.

**Download the Tutorial Files**

The ZIP file QuickStartTutorial.zip contains the tutorial's data sets, models, and score code, and is available at [http://support.sas.com/documentation/onlinedoc/brm/](http://support.sas.com/documentation/onlinedoc/brm/). Before you begin the tutorial, extract the tutorial files to a computer that is accessible to the SAS Metadata Server and to SAS Business Rules Manager users. If your SAS Metadata Server is separate from the SAS Application Server, the files must be placed on the SAS Application Server. Use WinZip to extract the files. If you are using a different extraction program, follow that program's instructions for extracting the files.

To download the files:

1. Create a folder on your local computer to store the tutorial files. The instructions refer to this folder as `<drive>`.  
2. Save the QuickStartTutorial.zip to `<drive>`.  
3. Open Windows Explorer to `<drive>`. Right-click `QuickStartTutorial.zip` and select Open. Click Open.  
4. Click the arrow on the Unzip button to open the Unzip from WinZip File Folder window.  
   
   *Note:* If you are using a previous release of Windows, from the WinZip window, click the Extract button. The Extract dialog box appears.  
5. Select `<drive>` from the Unzip to WinZip File Folder window.  
   
   *Note:* If you are using a previous release of Windows, in the Extract to box, select `<drive>` and click Extract.  

The zip file contains data and models files for the tutorial. The data for the Quick Start tutorial for SAS Business Rules Manager is in the folder `<drive>\QuickStartTutorial\Data`.  

**UNIX Specifics**

To complete the tutorial in a UNIX environment, first locate the CPORT file. Files that you use to import the data sets into UNIX are located in the
QuickStartTutorial.zip file. Instructions, as well as the sample code for performing an import, are provided in the Readme.txt file.

---

**Sign In**

To sign in to SAS Business Rules Manager:

1. In the address bar of your web browser, enter the URL for SAS Business Rules Manager and press **Enter**. The Sign In page appears.
   
   *Note:* Contact your system administrator if you need the URL for SAS Business Rules Manager.

2. Enter a user ID and password. Your user ID might be case sensitive, depending on the operating system that is used to host the application server. Your password is case sensitive.

   *Note:* To schedule jobs in a Windows environment, you must include the domain name when entering your user ID (for example, *domain\myuserId*).

3. Click **Sign In**.

---

**Define Data Sources**

To register new tables in the SAS Metadata Repository and add them to the list of data sources:

1. Select **Data ➔ Tables**.

2. Click **+** and select **Register Tables**. The Register Tables window appears.
3. Create a new Base SAS library.
   a. Select **Create a new library**.

   ![Register Tables dialog box]

   b. Specify **QSTutorial** for the name of the new library. The name cannot exceed 60 characters.

   c. (Optional) Specify a description for the library.

   d. Specify **QSTut** for the libref.

   e. Specify the location for the new library. This location is the folder in the SAS Metadata Repository where the library is stored.

   f. Select the server and the directory where the data tables for the quick start tutorial reside (for example, `C:\QuickStartTutorial\Data`).

   g. Click **Next**.

   *Note: If you click **Cancel** at this point, a folder for the library is created in the SAS Metadata Repository, but the folder does not appear in the list of data tables.*

4. Click ![Add All Tables](image) to add all of the tables to the **Selected tables** list.

5. Click **Finish**. The new library is now available in the list of data tables.
All of the content in your business rules database is contained within business rules folders. You must define at least one top-level folder. To define a top-level folder:

1. Select Business Rules ➤ Vocabularies. (You must display a category view to enable the folder menu options. You can select any of the categories under Business Rules.)

2. Click ✚, and select New Top-Level Folder.

3. Enter Tutorials for the folder name, and click OK.

Because multiple users might want to perform the tasks in the tutorial, each user should create a separate folder in the Tutorials folder. To create a new folder:

1. Right-click the Tutorials folder and select New Folder.

2. Enter a name for the folder such as myUserID. The examples in this tutorial use the ID sasdemo.

3. Click OK.

For more information, see Chapter 4, “Managing Business Rule Folders,” on page 33.
Create a Vocabulary, Entities, and Terms

Vocabularies, entities, and terms are the basic building blocks of a business rules database. Vocabularies contain entities, and entities contain terms. In this tutorial, you use the data table HMEQ_SCORE_PROB_OUTPUT, which you registered in “Define Data Sources” to import the terms for a new vocabulary. Then, you create a new entity and term manually in SAS Business Rules Manager and rename two of the imported terms.

For more information about vocabularies, entities, and terms, see Chapter 5, “Managing Vocabularies,” on page 37.

Create a New Vocabulary

To create a vocabulary:

2. Right-click on your folder in the Tutorials folder, and select New Vocabulary.
3. Enter HMEQ_Vocab for the vocabulary name, and click OK.

Import Terms From an Input Data Set

The easiest way to create new entities and terms is to import them from an input data set. The following steps import all of the terms in the data table HMEQ_SCORE_PROB_OUTPUT, which you registered in the SAS Metadata Repository in “Define Data Sources” on page 13.

4. Double-click HMEQ_Vocab to open the vocabulary.
5. Click to import the vocabulary entities and terms. The Import Terms window appears.
6. Select HMEQ_SCORE_PROB_OUTPUT as the data source, and enter BadLoans_Test as the entity name.
7. Select the check box to the left of the **Term** table header to select all of the terms, and click **OK**.

---

![Image of the Import Terms window](image-url)

**Import Terms**

- **Name:** HMEQ_Vocab
- **Data source:** QSTutorial.HMEQ_SCORE_PROB_OUTPUT
- **Entity name:** BedLoans_Test
- **Description:**
- **Library:** QSTutorial.HMEQ_SCORE_PROB_OUTPUT

### Select the terms to import

<table>
<thead>
<tr>
<th>Term</th>
<th>Type</th>
<th>Import Domain</th>
<th>Values</th>
<th>Discrete</th>
<th>Exclude from Input</th>
<th>Exclude from Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>CLAGE</td>
<td>Decimal</td>
<td>✓</td>
<td>0 - 1188.2335</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CLNO</td>
<td>Integer</td>
<td>✓</td>
<td>0 - 71</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DEBTING</td>
<td>Decimal</td>
<td>✓</td>
<td>1.6555399501</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DEUNQ</td>
<td>Integer</td>
<td>✓</td>
<td>01:23:45:67</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ID</td>
<td>Character</td>
<td>✓</td>
<td>ID_0000000000</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>JOB</td>
<td>Character</td>
<td>✓</td>
<td>Mgr,Office,Oh</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LANDLINE</td>
<td>Boolean</td>
<td>✓</td>
<td>True,False</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LOAN</td>
<td>Integer</td>
<td>✓</td>
<td>1500 - 89000</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

**OK** **Cancel**
SAS Business Rules Manager imports the terms and adds them to the entity named BadLoans_Test. If you expand the list, you see all of the terms that were imported.

8. Click ✗ to close the vocabulary.

Create a New Entity and Term

In addition to importing terms, you can create entities and terms manually. The following steps create a new entity and a new term.


10. Enter BadLoans_Actions as the entity name, and click OK.

12. Enter **BadLoanFlag** for the term name. Select **Boolean** for the data type, select **Exclude from input**, and click **OK**.

The **HMEQ_Vocab** vocabulary now contains two entities and several terms. You can display all of the terms in the vocabulary in the category view.
Rename Existing Terms

You can rename a term if it has not already been used in a rule set. Renaming is useful if the names of some of the terms in imported data are not indicative of their purpose. In the following steps, you rename two different terms.

13. Right-click the LANDLINE term in the BadLoans_Test entity, and select Rename.
14. Change the term name to HAS_LANDLINE and click OK.
15. Right-click the MODELScore term and select Rename.
16. Change the term name to LOAN_SCORE and click OK.

Create a Rule Set and Define Business Rules

A business rule specifies conditions to be evaluated and actions to be taken if those conditions are satisfied. Rules are grouped together into rule sets. In this tutorial, you create a single rule set with three rules.

For more information, see Chapter 7, “Managing Rules and Rule Sets,” on page 52.

Create a New Rule Set

2. Select your folder in the Tutorials folder.
4. Enter LoanScoreRules for the rule set name.
5. Select HMEQ_Vocab for the vocabulary and click Create. SAS Business Rules Manager opens the rule set and displays the Properties page.
Define Business Rules

To define the business rules for the new rule set, you enter condition and action expressions for the terms in the rule set into the rule set editor. The following steps define three simple rules.

6. Select the **Rules** page.
7. Expand the **BadLoans_Test** entity, and select the **HAS_LANDLINE**, **LOAN_SCORE**, and **REASON** terms.
8. Right-click on one of the highlighted terms, and select **Use as Condition Term**.
9. Right-click the **BadLoanFlag** term, and select **Use as Action Term**.
10. Enter the rule expressions into the rule set editor. Each row in the table represents a different rule. Enter the expressions for each term into the column for that term. You can enter expressions directly into the table cells, or you can use the equation editor. Click the **equation editor**.

Enter the expressions in the following table into the rule set editor.

<table>
<thead>
<tr>
<th>Rule</th>
<th>Condition Terms</th>
<th>Action Term</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>HAS_LANDLINE</td>
<td>LOAN_SCORE</td>
</tr>
<tr>
<td>Rule 1</td>
<td>&gt;.5</td>
<td>True</td>
</tr>
<tr>
<td>Rule 2</td>
<td>= True</td>
<td>&gt;.6 AND &lt;=.8</td>
</tr>
<tr>
<td>Rule 3</td>
<td>= True</td>
<td>&gt;.7 AND &lt;=.8</td>
</tr>
</tbody>
</table>

**Tip** If you do not specify an operator at the beginning of an expression, SAS Business Rules Manager adds an equal sign to the beginning of the expression.

**Tip** In condition expressions, when an AND or OR operator is followed immediately by another operator, SAS Business Rules Manager inserts the column term between the AND or OR operator and the operator that follows it.

See “Define Expressions for a Rule” on page 54 and “Terms and Operators Added by SAS Business Rules Manager” on page 63 for more information.
The following display shows the decision table with the rules that are defined for the LoanScoreRules rule set.

Validate and Save the Rule Set

When you save a rule set, SAS Business Rules Manager validates the content of the rule set before saving it. However, you can validate the rule set at any time while you are creating the rule set.

11. Click \( \square \) to validate the rule set.

12. Click \( \square \) to save the rule set.

Lock and Close the Rule Set

The last major step in creating a rules database is to create and publish rule flows. However, you cannot publish rule flows unless the rule set versions that are used in the rule flows are locked.

13. Select the Versions page.
14. Select Version 1.1 of the rule set, and click ✉️ to lock the selected version.

15. Click ✗ to close the rule set.

Create and Publish a Rule Flow

A business rule flow is a logical collection of rule sets that define multiple conditions and actions. The rule flow that you create in this tutorial contains only one rule set, but most rule flows contain multiple rule sets. After you add the rule set to the rule flow, you must specify the rule set version in order to be able to publish the rule flow.

For more information, see Chapter 8, “Creating and Publishing Rule Flows,” on page 76.

To create and publish a rule flow:
2. Right-click on your folder in the Tutorials folder, and select New Rule Flow.
3. Enter Score_Loan for the rule flow name and click Create. SAS Business Rules Manager opens the rule flow and displays the Properties page.
4. Select the Rule Sets page.
5. In the rule sets list, right-click LoanScoreRules and select Add To Rule Flow.
6. Specify the locked version of the rule set in the rule flow. Click Use latest in the Version column, and select 1.1.
7. Click to save the rule flow.

8. Click to publish the rule flow. The Choose a Location window appears.

9. Select the location where you want to publish the rule flow, and click OK.

10. Click to close the rule flow.
Chapter 3
Managing Data Tables

About Managing Data Tables

The Data category enables you to manage your list of data tables from within SAS Business Rules Manager. You can create new Base SAS libraries, add and remove tables, view table data and metadata, create and delete table summaries, and associate attachments and comments with tables. The application uses these data tables whenever it needs to access data, such as for rule discovery and rule flow testing.

You can view the list of tables by selecting Data ➔ Tables. There are three ways to add tables to the list.

- You can use SAS Visual Data Builder to create new tables and add them to the list. See “Adding Tables Using SAS Visual Data Builder” on page 26 for more information.
- If the table is already registered in the SAS Metadata Repository, you can add the table to the list as described in “Add a Table That Is Registered in Metadata” on page 26.
- If the table is not already registered in the SAS Metadata Repository, you can add a new table as described in “Register and Add New Tables” on page 26.

Note: Tables added to the Data category view must be created with the BASE engine.
Chapter 3 • Managing Data Tables

Note: If you do not have the appropriate permissions to access a folder, then the tables and libraries are not listed in the Data category view.

Adding Tables Using SAS Visual Data Builder

SAS Visual Data Builder enables analysts and data administrators to perform data preparation for analytics. You can design queries to perform joins, add calculated columns, and subset and sort data. Several productivity features speed the creation of columns based on common aggregation functions.

Once you design your queries, you can reuse them as subqueries for more sophisticated queries, export them as jobs for scheduling, or schedule them directly from the user interface.

The application has data import features that enable you to access data from spreadsheets, delimited files, and SAS data sets. Once you import the data, you can prepare it for analysis or join it with existing data.

The application provides a series of features that you can use to extract and transform data from multiple sources and create new data tables.

To access SAS Visual Data Builder, select **Data ➤ Tables**. Click to start SAS Visual Data Builder. For more information about SAS Visual Data Builder, click to access *SAS Visual Analytics: User’s Guide* and videos about using SAS Visual Data Builder.

Add a Table That Is Registered in Metadata

If a data table has already been registered in the SAS Metadata Repository, you can add it to the list of data sources if the table was created with the BASE engine. To add a table:

1. Select **Data ➤ Tables**.
2. Click and select **Add Registered Table**. The Choose an Item window appears.
3. Select the table that you want to add, and click **OK**.

Register and Add New Tables

You can create new Base SAS libraries and register tables by using SAS Business Rules Manager. You can register only tables that were created with the BASE engine. To register new tables in the SAS Metadata Repository and add them to the list of data sources:

1. Select **Data ➤ Tables**.
2. Click and select **Register Tables**. The Register Tables window appears.
Note: You cannot use the Register Tables option to add a table that is already registered. You must select Add Registered Table instead. See “Add a Table That Is Registered in Metadata” on page 26.

3. Select an existing library, or create a new Base SAS library.

To use an existing library:
   a. Select Use an existing library.
   b. Click and select the library.
   c. Click Next.

To create a new Base SAS library:
   a. Select Create a new library.
   b. Specify a name for the new library. The name cannot exceed 60 characters.
   c. (Optional) Specify a description for the library.
   d. Specify a libref. A libref is a name that SAS uses to refer to the library. Enter a unique name of eight characters or less.
   e. Specify the location for the new library. This location is the folder in the SAS Metadata Repository where the library is stored.
   f. Select the server and the directory where the data tables reside.
   g. Click Next.

   Note: If you click Cancel at this point, a folder for the library is created in the SAS Metadata Repository, but the folder does not appear in the list of data tables.

4. Select the tables that you want to add to the library, and click to add the tables to the Selected tables list. Click to add all of the tables to the Selected tables list.

5. Click Finish.

---

Edit Table Properties and View Table Metadata

The Properties page displays table metadata. On this page, you can edit the data source name and description, and change the table associated with the data source name.

1. Select Data ➔ Tables.

2. Double-click on the table whose properties you want to edit. The Properties page appears.
The Properties page displays table metadata such as the number of columns, the table location, and information about each column in the table.

3. Edit the data source name and description, or click to select a different table as the data source.

4. Click to save the changes.

---

**View Table Data**

To view table data:

1. Select Data ➔ Tables.

2. Double-click on the table that you want to view.

3. Select the Table View page.
On the Table View page, you can control the display by selecting specific columns in the Columns section. The Column Information section displays information about the currently selected column.

To sort the table based on the values in a particular column, click on the column heading. If the column is sorted in ascending order, a ▲ appears beside the column heading. When the column is sorted in descending order, a ▼ appears.

Filter Data in the Table View

You can filter the rows that are shown on the Table View page in either of the following ways:

• Click 🛀 above the table. The Filter window appears. Enter a valid SQL expression, and click Apply.

• Right-click on a value in the table. SAS Business Rules Manager displays several predefined filter options. You can select any of these options. Depending on which option you select, you might be prompted to enter data values for the query.
The expression that you enter is displayed above the data table, and the table is filtered accordingly.

To clear the filter and display the entire table, click \(\times\).

For more information about SQL expressions, see \textit{SAS FedSQL Language Reference}.

---

### Create a New Table Summary

To create a new table summary:

1. Select Data \(\Rightarrow\) Tables.
2. Double-click on the table for which you want to add a summary.
3. Select the Summary page.
4. Click \(\downarrow\).
5. In the New Summary window, select the Collection period and the specific date or time values for the collection period that is represented by the data in the table.
   
   \textit{Note:} The Collection period is not used to filter the data.

6. \(\text{(Optional)}\) Specify a summary description.
7. Click Run. SAS Business Rules Manager runs a process to summarize the data and adds the new summary to the Summary page.

Double-click on the summary to open it.
The following display shows the Summary page for the Claim_History table. The collection period represented by the data in the table is 05/29/14.

Add Attachments to a Table

To add an attachment such as a document file or an image file:
1. Select the Attachments page.
2. Click +, and select the attachment file.
3. Click .

Note: You can delete an attachment by selecting the attachment and clicking .

Add Comments to a Table

You can add new comments or reply to existing comments. To add a new comment:
1. Select the Comments page.
2. Enter a topic title and enter the comment. The topic title is required, and the field for comments does not appear until you enter the topic title.

3. (Optional) Click to add an attachment such as an image or a document.

4. Click Post.

To reply to an existing comment, enter your reply in the field immediately below the topic title for the existing comment, and click Post.

Click to see comments that have been posted by others.

To search for text in the comments, enter text in the search field at the top of the Comments page.

---

**Delete a Table Summary**

To delete a table summary:

1. Select Data → Tables.
2. Double-click on the table whose summary you want to delete.
3. Select the Summary page.
4. Select the summary that you want to delete.
5. Click .

---

**Remove a Table**

Removing a table from the list of data sources does not delete the table from file system.

To remove a table from the list of data sources:

1. Select Data → Tables.
2. Select the table that you want to remove from the list.
3. Click .
Chapter 4
Managing Business Rule Folders

About Business Rules Folders

Before you create any vocabularies, lookup tables, rule sets, or rule flows, you need to create business rules folders. Content that is related to business rules is stored in business rules folders.

Create New Top-Level Folders

To create a new top-level folder:

1. Click 🗂️, and select New Top-level Folder.
2. In the New Folder window, enter the name of the new folder. Folder names are limited to 100 characters.
3. (Optional) Enter a description for the new folder. Descriptions are limited to 256 characters.
4. Click OK.

Create New Folders

To create a new folder within another folder:

1. Select the parent folder in which you want to create a new subfolder.
2. Click 𝕐, and select **New Folder**.
3. In the New Folder window, enter the name of the new folder. Folder names are limited to 100 characters.
4. (Optional) Enter a description for the new folder. Descriptions are limited to 256 characters.
5. Click **OK**.

### Rename a Folder

To rename a folder, right-click on the folder, and select **Rename**. Enter the new name, and click **OK**. Folder names are limited to 100 characters.

### Move a Folder

To move a folder, right-click on the folder, and select **Move Folder**. Select a new location for the folder, and click **Move**.

*Note:* You cannot move a folder up to the level of a top-level folder. A folder cannot be moved into one of its own folders.

### Delete a Folder

A folder must be empty before you can delete it. To delete a folder, right-click on the folder, and select **Delete**.
Part 2

Defining a Rules Database

Chapter 5
  Managing Vocabularies ........................................ 37

Chapter 6
  Using Lookup Tables And Functions .......................... 45

Chapter 7
  Managing Rules and Rule Sets ................................ 51

Chapter 8
  Creating and Publishing Rule Flows ............................ 75
Chapter 5
Managing Vocabularies

Introduction to Vocabularies, Entities, and Terms

Vocabularies, entities, and terms are the basic building blocks of a business rules database. Vocabularies contain entities, and entities contain terms.

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vocabulary</td>
<td>Vocabularies contain one or more business entities. Vocabularies enable you to categorize and structure the entities and terms needed to create a rules database.</td>
</tr>
<tr>
<td>Entity</td>
<td>An entity is an object in a business domain. For example, an entity could be Customer, Transaction, or Account. Entities contain terms. They group terms into logical units. Entities are not mapped to tables or to table columns when rules flows are published.</td>
</tr>
</tbody>
</table>
A term is an attribute of an entity. For example, a customer entity might have terms such as name, address, and income. A transaction entity might contain terms for date, time, transaction amount, and account number. Terms are the objects with which you build business rules.

A business rule can have condition terms and action terms. Suppose your rule is if balance>1000 then account="premium". The term balance is a condition term, and account is an action term.

Terms are mapped to table columns by the applications that use published rule flows that are within metadata.

**Tips for Creating Entities and Terms**

- Before you define vocabulary entities and terms, review the structure of the tables that input values will come from. Vocabularies should be structured similarly to these tables to ensure that terms are mapped correctly to input columns. Coordinate your work with the groups that will be using the vocabulary. Coordination helps ensure that the vocabulary structure meets their requirements.

- Boolean data can be represented with terms that are defined either as Boolean data types or as Character data types. In some cases, Boolean values might be better represented by using terms defined as Character. For example, if your data already uses yes and no for Boolean data, then you probably want to use a Character term to process these values rather than try to translate those values to true and false.

**Create a Vocabulary**

To create a new vocabulary:

2. Right-click on the folder where you want to create the new vocabulary, and select New Vocabulary. Alternatively, you can select the folder, click [ ], and then select New Vocabulary. The New Vocabulary window appears.
3. Enter the name of the new vocabulary. Vocabulary names can contain up to 32 characters and must be unique within an entire rules database. Vocabulary names are case insensitive. For example, SAS Business Rules Manager considers name to be equal to NAME.
4. (Optional) Enter a description for the new vocabulary. Descriptions are limited to 256 characters.
5. Click OK.
Create New Entities

To create a new entity from the Vocabulary category view:

1. Right-click on the vocabulary where you want to create the new entity, and select **New Entity**. Alternatively, you can select the vocabulary, click ![entity icon], and then select **New Entity**. The New Entity window appears.

   *Note:* If you open a vocabulary, you can click ![entity icon] to create a new entity.

2. Enter the name of the new entity. Entity names can contain up to 32 characters and must be unique within a vocabulary. Entity names are case insensitive. For example, SAS Business Rules Manager considers `name` to be equal to `NAME`.

3. (Optional) Enter a description for the new entity. Descriptions are limited to 256 characters.

4. Click **OK**.

Create New Terms

To create a new term:

1. Right-click on the entity where you want to create the new term, and select **New Term**. Alternatively, you can select the entity, click ![term icon], and then select **New Term**. The New Term window appears.

2. Enter the name of the new term. Term names can contain up to 32 characters and must be unique within a vocabulary. Term names are case insensitive. For example, SAS Business Rules Manager considers `name` to be equal to `NAME`.

   *Note:* Do not use any of these operators or keywords as term names: AND, OR, IN, NOT, LIKE, TRUE, or FALSE. Do not use `_N_` or any DS2 reserved word as a term name. See “Reserved Words in the DS2 Language” in Chapter 20 of SAS DS2 Language Reference at [http://support.sas.com/documentation/onlinedoc/base/index.html](http://support.sas.com/documentation/onlinedoc/base/index.html).

3. (Optional) Enter a description for the new term. Descriptions are limited to 256 characters.

4. Select the data type for the new term.

5. Select the domain type for the new term.

6. (Optional) Specify the domain values for the new term. Domain values are the set of expected values for a term. See “Specify Domain Values” on page 41 for more information.

7. (Optional) Select **Exclude from input** if you do not want the term to be mapped to a column in an input data set. (The application expects all terms to be mapped to columns in an input data set.)

8. (Optional) Select **Exclude from output** to exclude a term from the output data sets that are generated by rule flows.
To create a temporary term for use only while a rule flow is executing, select both Exclude from input and Exclude from output.

9. Click OK.

---

**Import Terms from a Data Source**

To import terms from a data source:

1. Create a new vocabulary or open an existing vocabulary. For information, see “Create a Vocabulary” on page 38.

2. Click . The Import Terms window appears.

3. Select the data source from which you want to import terms. SAS Business Rules Manager displays the terms, their type, and domain information.

4. Enter the entity name where you want to add the terms.

5. (Optional) Enter a description for the entity.

6. Select the terms and domain values that you want to import.

   **TIP** To select all of the items in a column, select the box beside the column heading.

7. Select the Discrete box for terms that have a discrete set of values. For more information, see “Specify Domain Values” on page 41.

8. All of the imported terms are included in both the input and the output unless you exclude them. Select any terms that you want to exclude. See Step 7 and Step 8 of “Create New Terms” on page 39 for more information.
Specify Domain Values

Domain values are the set of expected values for a term. Domain values are not used to validate rules. They are used to enable faster and easier rule authoring. They are displayed in the Expression Editor, which enables you to add a value to an expression by double-clicking on the value.

Domain values can include term or variable names. For continuous values, you can use the greater than (>), less than (<), and equal (=) signs to set limits for ranges. You cannot include a semi-colon (;) within a domain value. You do not need to enclose Character values in quotation marks unless the value itself contains an apostrophe (’).

Separate individual domain values with a semi-colon (;).

Note: To enter continuous Date and Datetime values, enclose the values in single quotation marks, followed by a d or dt as shown in the following table.

The following table shows examples of domain values.

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Domain Type</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Character</td>
<td>Discrete</td>
<td>high risk;low risk</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;d'oscail&quot;;&quot;d'fhill&quot;</td>
</tr>
<tr>
<td>Integer</td>
<td>Discrete</td>
<td>0;800;3500</td>
</tr>
<tr>
<td></td>
<td>Continuous</td>
<td>&gt;100;&lt;=myterm</td>
</tr>
<tr>
<td>Decimal</td>
<td>Discrete</td>
<td>3.14;12.98</td>
</tr>
<tr>
<td></td>
<td>Continuous</td>
<td>&gt;1.25;&lt;=N1</td>
</tr>
<tr>
<td>Date</td>
<td>Discrete</td>
<td>01jul2012;31jul2012</td>
</tr>
<tr>
<td></td>
<td>Continuous</td>
<td>&gt;='01jan2013'd;&lt;='31dec2013'd</td>
</tr>
<tr>
<td>Datetime</td>
<td>Discrete</td>
<td>01jul2012:10:52:00;31jul2012:23:00:00</td>
</tr>
<tr>
<td></td>
<td>Continuous</td>
<td>&lt;='01jul2012:00:00:00'dt;'31jul2012:23:00:00'dt</td>
</tr>
<tr>
<td>Boolean</td>
<td></td>
<td>By default, Boolean values are set to True and False and cannot be changed.</td>
</tr>
</tbody>
</table>
Edit Existing Vocabularies, Entities, or Terms

To edit an existing object:
1. Right-click on the object that you want to edit, and select Open. Alternatively, you can select the object, and then click Open in the toolbar.
2. Edit the object’s properties as needed.
3. Click

Delete Vocabularies, Entities, or Terms

Note: You cannot delete a vocabulary, entity, or term if it is used in a rule set.

You can delete an object in one of two ways:
• Right-click on the object, and select Delete.
• Select the object, and click .

Search for Rule Sets by Term

To find all of the rule sets that use a specific term:
2. Select the term that you want to search for and click . The Search for Rule Sets window appears.

TIP You do not have to select a term before you click . You can click , and manually enter the term that you want to search for.
3. Select the usage that you want SAS Business Rules Manager to search for.

Anywhere  finds terms that are used as condition terms, action terms, or in expressions

As a condition term  finds terms that are used only as condition terms (terms that have been added to the column or row headings of the decision table)

As an action term  finds terms that are used only as action terms (terms that have been added to the column or row headings of the decision table)

In an expression  finds terms only when they are used in rule expressions
4. Click Search. If the search returns results, SAS Business Rules Manager displays all of the rule sets and versions in which it found the term.
To open one of the rule sets, select the rule set in the search results list, and click ![Open](image).  

**Note:** If a term is referenced implicitly in an expression, then selecting **In an expression** and searching for that term does not find it. For example, if you enter the expression $+10$ into the rule set editor for the term `myterm`, then the resulting expression for `myterm` is `=myterm+10`. Because the expression that you entered into the rule set editor did not explicitly reference `myterm`, the search was not successful.
Chapter 6
Using Lookup Tables And Functions

About Lookup Tables and Functions

SAS Business Rules Manager provides the ability to import lookup tables and reference them from rules. Lookup tables are tables of key-value pairs. For example, you can use a lookup table to retrieve a part name based on the part code number or to retrieve the full name for a country based on its abbreviation.

You can import lookup data from comma-separated-values (CSV) files such as those created by Microsoft Excel into lookup tables in SAS Business Rules Manager. You can re-import updated CSV files as needed to refresh the lookup tables.
In a lookup table, each *lookup key* is associated with a *lookup value*. Lookup keys must be unique within each lookup table. Lookup values are limited to 512 characters.

SAS Business Rules Manager provides two functions, Lookup and LookupValue, that enable you to determine whether a lookup key exists in a lookup table and to retrieve a lookup value from a lookup table.

![Table of Country Codes](image)

### Create a New Lookup Table

You create a new lookup table by importing a CSV file.

To create a new lookup table:

1. Select the **Lookups** category.

2. Right-click on the folder where you want to create the new lookup table, and select **New Lookup Table**. The New Lookup Table window appears.

3. Enter a name for the new lookup table. Names are limited to 32 characters and can contain only alphanumeric characters and underscores. Lookup table names must be unique within the business rules database. Lookup table names are case insensitive. For example, SAS Business Rules Manager considers **NAME** to be equal to **name**.

4. (Optional) Enter a description for the new lookup table. Descriptions are limited to 256 characters.

5. Click **», and select the CSV file that contains the lookup data.

6. Click **OK**.
Refresh a Lookup Table

To refresh a lookup table:

1. Right-click on the lookup table that you want to refresh, and select Refresh Lookup Table. The Refresh Lookup Table window appears.
2. Click ..., and select the CSV file that contains the lookup data.
3. Click OK.

Delete a Lookup Table

Note: You cannot delete a lookup table if it is referenced in a rule.

To delete a lookup table:

1. Select the Lookups category.
2. Select the lookup table and click .

Copy a Lookup Table

To copy a lookup table:

1. Right-click on the lookup table, and select Copy Lookup Table. The Copy Lookup Table window appears.
2. Enter a name for the new lookup table. Names are limited to 32 characters and can contain only alphanumeric characters and underscores. Lookup table names must be unique within the business rules database. Lookup table names are case insensitive. For example, SAS Business Rules Manager considers NAME to be equal to name.
3. (Optional) Enter a description for the new lookup table. Descriptions are limited to 256 characters.
4. Click OK.

Move a Lookup Table

You cannot move a lookup table if it is open. To move a lookup table:

1. Right-click on the lookup table, and select Move Lookup Table. The Choose a Location window appears.
2. Select the folder where you want to move the lookup table, and click Move.
Verify Lookup Keys (Lookup Function)

You can use the Lookup function to verify that a key value exists in a lookup table. You can specify the Lookup function in condition expressions only. Specify the Lookup function as the expression for the term whose value is the lookup key that you want to search for. The syntax of the Lookup function is as follows:

\[ \text{Lookup} \left( \text{"lookup_table_name"} \right) \]

For \text{lookup_table_name}, specify the name of the lookup table that you want to search.

For example, if you want to verify that the value of the term Ctry_Key exists as a key value in the table Country_Codes, enter the Lookup function as the expression for the Ctry_Key term as shown in the following display.

The Lookup function returns a value of \text{True} or \text{False}, depending on whether the key value exists in the lookup table. For example, suppose the Ctry_Key column in the current input record contains the value “CA”. If the Country_Codes lookup table contains the lookup key “CA”, then the expression shown in the display above evaluates to True.

\text{Note:} If an expression contains the Lookup function, then the expression cannot contain anything else.

Get Lookup Values (LookupValue Function)

You can use the LookupValue function to retrieve a lookup value from a lookup table. You can specify the LookupValue function in action expressions only. The syntax of the LookupValue function is as follows:

\[ \text{LookupValue} \left( \text{"lookup_table_name", term_or_string} \right) \]

\text{lookup_table_name} the name of the lookup table that you want to search.

\text{term_or_string} a term or character string that specifies the lookup key for the value that you want to retrieve. Enclose character strings in quotation marks.

For example, suppose the term Ctry_Key contains a lookup key. To retrieve the lookup value that is associated with that key from the table Country_Codes, enter the following expression for the Ctry_Key term:

\[ \text{LookupValue} \left( \text{"Country_Codes", Ctry_Key} \right) \]
The first few entries in the Country_Codes lookup table are shown below.

<table>
<thead>
<tr>
<th>Key</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>AU</td>
<td>Australia</td>
</tr>
<tr>
<td>BR</td>
<td>Brazil</td>
</tr>
<tr>
<td>CA</td>
<td>Canada</td>
</tr>
<tr>
<td>CR</td>
<td>Costa Rica</td>
</tr>
</tbody>
</table>

For example, suppose the Ctry_Key column in the current input record contains the value “CA”. The Country_Codes lookup table contains the lookup key “CA”, and the lookup value that corresponds to that key is “Canada”. The expression shown in the display above assigns the value “Canada” to the term Country_Name.

**Note:** If an expression contains the LookupValue function, then the expression cannot contain anything else.
Chapter 7
Managing Rules and Rule Sets

About Rules, Rule Sets, and Expressions ........................................... 52
How Rules Are Evaluated and Rule-Fired Records ............................... 53
Create a New Rule Set ............................................................................ 53
Defining New Rules in the Rule Set ...................................................... 53
  Add a New Rule ................................................................................. 53
  Define Expressions for a Rule .......................................................... 54
  Controlling Which Conditions Are Evaluated .................................... 56
  Using the Expression Editor ............................................................. 57
  Punctuation for Data Values ............................................................. 60
  Operators for Use in Expressions ....................................................... 61
  Using the LIKE Operator .................................................................. 62
  Using Functions in Expressions ......................................................... 63
  Working with Missing Values ............................................................ 63
  Terms and Operators Added by SAS Business Rules Manager .......... 63
  Examples of Expressions ................................................................ 64
Validate the Expressions in a Rule Set .................................................. 66
Change the Order of Rules in a Rule Set ................................................. 66
  Move a Rule to a New Position in a Rule Set ...................................... 66
  Swap Two Rules ............................................................................... 66
Copy Rules and Expressions .................................................................. 67
  Copy an Entire Rule ......................................................................... 67
  Copy Text within a Rule ................................................................. 67
Delete Rules and Expressions ............................................................... 68
  Delete a Rule .................................................................................. 68
  Cut and Paste Text within a Rule .................................................... 68
Edit the Properties of a Rule Set .......................................................... 68
Edit the Properties of a Rule ............................................................... 68
Display Usage Information for a Rule Set .............................................. 69
Managing Rule Set Versions ................................................................. 70
  About Rule Set Versions .................................................................. 70
  Set the Displayed Version ............................................................... 70
  Create a New Version of a Rule Set .................................................. 70
  Lock a Rule Set Version ................................................................... 70
  Edit a Version Description .............................................................. 71
Add Comments to a Rule Set ............................................................... 71
About Rules, Rule Sets, and Expressions

A rule specifies conditions to be evaluated and actions to be taken if those conditions are satisfied. Rules are grouped together into rule sets. Rule sets are logical collections of rules that are grouped together because of interactions or dependencies between the rules or because they are processed together when they are published.

Most rules correspond to this form:

\[ \text{if condition expressions then action expressions} \]

For example, suppose you have the following rule:

\[ \text{if customer_debt > customer_assets then app_status = "Decline"} \]

In this case, customer_debt is a condition term, and customer_debt > customer_assets is a condition expression. The term app_status is an action term, and app_status = "Decline" is an action expression. To enter this rule into the decision table, you first need to add the terms customer_debt and app_status to the decision table, and then enter the expressions under the terms to which the expressions apply.

The following figure shows the rule set editor with this rule added to it:

<table>
<thead>
<tr>
<th>Condition Term</th>
<th>Action Term</th>
</tr>
</thead>
<tbody>
<tr>
<td># customer_debt</td>
<td>△ app_status</td>
</tr>
<tr>
<td>1 if customer_debt &gt; customer_assets = &quot;Decline&quot;</td>
<td></td>
</tr>
</tbody>
</table>

A single rule can have multiple terms, conditions, and actions. Multiple condition expressions within the same rule are joined together with the AND operand. For example, suppose you define the following rule in SAS Business Rules Manager:

SAS Business Rules Manager generates the following rule condition:

\[ \text{(HomeOwner = True) AND (Credit_Score > 700)} \]

Action expressions are always assignment statements.
How Rules Are Evaluated and Rule-Fired Records

By default, the condition expressions for all rules in a rule set are evaluated sequentially regardless of the results of previous rules. However, you can use the ELSE and OR operators to control whether the condition expression for a rule is evaluated. See “Controlling Which Conditions Are Evaluated” on page 56 for more information.

If a rule’s condition expression evaluates to True, SAS Business Rules Manager executes the rule’s action expression.

If a rule’s condition evaluates to True, the rule is said to have fired.

By default, every time a rule fires, it generates a rule-fired record. However, you can control when rule-fired records are generated by using the Record rule-fired data check box. See Step 7 of “Add a New Rule” on page 53.

Note: A rule that does not have a condition expression does not generate a rule-fired record.

Create a New Rule Set

To create a new rule set:

2. Right-click on the folder where you want to create the new rule set, and select New Rule Set. The New Rule Set window appears.
3. Enter a name for the new rule set. Rule set names are limited to 100 characters and must be unique within a folder.
4. (Optional) Enter a description for the new rule set. Descriptions are limited to 256 characters.
5. Select the vocabulary that is associated with the new rule set.
6. Click Create. SAS Business Rules Manager opens the new rule set and displays the Properties page.

Defining New Rules in the Rule Set

Add a New Rule

1. Open the rule set where you want to add the new rule.
2. Select the Rules page.

The default view of a rule set is the horizontal view. In the horizontal view, the terms used by the rules are displayed across the top of the rule set editor, and the editor has one row for each rule in the rule set. To switch to the vertical view, select Vertical from the menu in the toolbar above the editor. In the vertical view, the terms used by
the rules are displayed in the left column, and the editor has one column for each rule in the rule set.

3. Click +.

4. Add any additional terms that the new rule requires, and add expressions for the new rule in the table cells in the rule editor. See “Define Expressions for a Rule” on page 54 for more information.

5. (Optional) Change the order of the new rule. The rule order, in addition to the IF, ELSE, or OR keyword (see “Controlling Which Conditions Are Evaluated” on page 56), controls how rules are evaluated within the rule set.

   **TIP** You can also change the order of the rules later by right-clicking on a rule and selecting either Reorder or Swap. See “Change the Order of Rules in a Rule Set” on page 66 for more information.

6. (Optional) Modify the name of the new rule on the Rule Details tab. Rule names are limited to 100 characters and must be unique within a rule set.

7. (Optional) Clear the Record rule-fired data check box on the Rule Details tab if you do not want a rule-fired record to be written each time this rule fires.

8. (Optional) Enter a description for the new rule on the Rule Details tab.

9. Click .

---

**Define Expressions for a Rule**

To define the expressions for a rule:

1. Add any additional terms to the rule set editor that the rule requires. You can add a single term in one of two ways:
   
   • Right-click on the term in the Vocabulary pane, and select either **Use as condition term** or **Use as action term**.
   
   • Drag the term from the Vocabulary pane onto a column in the rule set editor.

   You can also add multiple terms at the same time.

   • If the terms that you want to add to the table all belong to the same entity, you can add the entire entity to the table in the same way that you add a single term. Note that an entity can contain dozens of terms, and you cannot undo this operation after you have added the terms. You must delete terms one at a time.

   • If the terms do not all belong to the same entity, select the terms and drag them onto the table, or use the pop-up menu as you would for a single term. To select a consecutive set of terms, click on the first term, hold down the Shift key, and click on the last term. To select nonconsecutive terms, hold down the Ctrl key, and click on each term that you want to select.

   For example, if your rule is **If balance < 100 then risk = "high"**, the condition term is **balance** and the action term is **risk**.

   **TIP** By default, terms are listed in the table in alphabetical order. You can reorder the terms by dragging the terms in the column or row headings.

   **TIP** You can add new entities and terms by clicking in the Vocabularies pane. You can also edit existing entities and terms by right-clicking on the entity or term and selecting the appropriate option. See “Create New Entities” on page 39 and “Create New Terms” on page 39 for more information.
2. (Optional) Select the operator for the rule. The default operator is IF. See “Controlling Which Conditions Are Evaluated” on page 56 for more information.

3. For each term that is used in the new rule, specify the expression that applies to that term in the row or column for the new rule. For example, if the rule is If balance < 100 then risk = "high", the expression for balance is < 100, and the expression for risk is = "high".

Expressions can be up to 1024 characters long. They can contain numeric constants, character strings, vocabulary terms, operators, and SAS DS2 functions.

Condition expressions can contain the LOOKUP function, and action expressions can contain the LOOKUPVALUE function. However, if the expression contains the LOOKUP or LOOKUPVALUE function, then the expression cannot contain anything else.

**TIP** A rule that does not have a condition expression always executes.

**TIP** If a rule has been assigned the IF operator and a condition expression but it does not have an action expression, the condition expression is evaluated, but no action is taken. (See “Controlling Which Conditions Are Evaluated” on page 56 for information about the IF operator.)

You can enter expressions directly into the decision table, or you can use the Expression Editor to create and edit expressions. To open the Expression Editor, click in the table cell, and select .

As you enter expressions into each cell, SAS Business Rules Manager displays the rule conditions and actions, including the operators and term names that are added by SAS Business Rules Manager, on the Rule Details tab. (See “Terms and Operators Added by SAS Business Rules Manager” on page 63.) For example, suppose you enter the following rule in the editor:

<table>
<thead>
<tr>
<th>Condition Term</th>
<th>Action Term</th>
</tr>
</thead>
<tbody>
<tr>
<td>Credit_Score</td>
<td>Down_Payment</td>
</tr>
<tr>
<td>&gt;= 720 AND &lt;750</td>
<td>&gt;= 20</td>
</tr>
</tbody>
</table>

SAS Business Rules Manager displays the following expressions on the Rule Details tab.

**Condition:** (Down_Payment < 20) AND (Credit_Score >= 720 and Credit_Score < 750)

**Action:** Risk_Category = 'Medium'

For more information about entering expressions, see the following topics:

- “Using the Expression Editor” on page 57
- “Punctuation for Data Values” on page 60
- “Operators for Use in Expressions” on page 61
- “Using the LIKE Operator” on page 62
- “Verify Lookup Keys (Lookup Function)” on page 48
- “Get Lookup Values (LookupValue Function)” on page 48
- “Using Functions in Expressions” on page 63
- “Working with Missing Values” on page 63
- “Terms and Operators Added by SAS Business Rules Manager” on page 63
- “Examples of Expressions” on page 64
4. Click to save the rule set. SAS Business Rules Manager validates the syntax of the expressions. If it does not detect any problems, it saves the rule set. See “Validate the Expressions in a Rule Set” on page 66 for more information.

**Controlling Which Conditions Are Evaluated**

You add conditional processing within a rule set by using the IF, ELSE, and OR operators. By default, rules are assigned the keyword IF, which means that the rule’s condition is evaluated regardless of the results of previous rules. You can change this outcome by changing the operator for a rule to ELSE or OR.

If you set a rule’s operator to ELSE, then the rule’s condition is evaluated only if the previous rule’s condition evaluated to false. For example, given the rule set shown in the following display, if Order Quantity is 12, the condition for rule 1 evaluates to false, the condition for rule 2 evaluates to true. Therefore, the action for rule 2 is executed. The conditions for rules 3 and 4 are not evaluated.

Use the OR operator to break up very long condition expressions into multiple condition expressions and to execute the same action expression for each of the conditions. If you assign the OR operator to a rule, then you cannot enter an action expression for the rule. If any of the conditions evaluate to true, SAS Business Rules Manager executes the action of the last rule that was assigned the IF or ELSE operator. When you have several consecutive rules that are all assigned the OR operator, only the action for the first rule whose condition evaluates to true is executed. The conditions for the remaining consecutive OR rules are not evaluated.

For example, suppose you have a very long condition expression such as the one shown in the following display.

As shown in the next display, you can break this expression into four different rules and use the OR operator, which makes the rule much easier to read and edit.

<table>
<thead>
<tr>
<th>Condition Term</th>
<th>Action Term</th>
</tr>
</thead>
<tbody>
<tr>
<td>#</td>
<td>Order Quantity</td>
</tr>
<tr>
<td>1</td>
<td>&lt;= 5</td>
</tr>
<tr>
<td>2</td>
<td>&gt;= 10 AND &lt;= 15</td>
</tr>
<tr>
<td>3</td>
<td>&gt;= 20 AND &lt;= 25</td>
</tr>
<tr>
<td>4</td>
<td>&gt;= 30</td>
</tr>
</tbody>
</table>
For example, in the following rule set, rules 1 though 4 use the action expression that is defined for rule 1. Rules 5 through 7 use the action expression that is defined for rule 5.

**Display 7.1  Rule Set That Defines Seven Rules in Two IF Blocks**

<table>
<thead>
<tr>
<th></th>
<th>Condition Term</th>
<th>Action Term</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>T</td>
<td>=False, =5</td>
</tr>
<tr>
<td>2</td>
<td>Or</td>
<td>=False, =&gt;10 AND &lt;=15</td>
</tr>
<tr>
<td>3</td>
<td>Or</td>
<td>=False, =&gt;20 AND &lt;=25</td>
</tr>
<tr>
<td>4</td>
<td>Or</td>
<td>=False, =&gt;30</td>
</tr>
<tr>
<td>5</td>
<td>T</td>
<td>=False, =&gt;6 AND &lt;=8</td>
</tr>
<tr>
<td>6</td>
<td>Or</td>
<td>=False, =&gt;18 AND &lt;=19</td>
</tr>
<tr>
<td>7</td>
<td>Or</td>
<td>=False, =&gt;29</td>
</tr>
</tbody>
</table>

An IF block is a series of rules that begins with an IF operator and extends up to but does not include the next IF operator. In the rule set shown in **Display 7.1 on page 57**, rules 1 to 4 are an IF block and rules 5 to 7 are a second IF block.

**Note:** A rule that does not have a condition expression must be the last rule in an IF block.

**Using the Expression Editor**

**Open the Expression Editor**

To open the Expression Editor, click in a cell in the rule set editor, and click .

The **Lookup** tab is available only for condition terms, and the **Lookup Value** tab is available only for action terms. Buttons for some of the operators might be disabled depending on the data type of the term, and because action expressions can be assignment expressions only.
Build an Expression in the Expression Editor

To define expressions that do not use the LOOKUP or LOOKUPVALUE functions, enter the expression on the Expression tab. Click on the operators, vocabulary terms, and domain values as needed to add them to the expression. The Expression Editor builds the expression in the top field. To add date constants to the expression, click ⌦. To add numeric constants, character strings, or functions to the expression, enter them directly into the top field. (Remember to use the correct punctuation. See “Punctuation for Data Values” on page 60.) When you are finished, click OK. The Expression Editor validates the syntax of the expression. If the editor does not find any problems, it adds the expression to the cell in the table where you opened the editor. You can click Validate at any time to check the syntax of the expression that you are building.

To build an expression that uses the LOOKUP or LOOKUPVALUE functions, switch to the Lookup or LookupValue tabs. You can enter the LOOKUP function in condition expressions only, and you can enter the LOOKUPVALUE function in action expressions only. See “Specify the LOOKUP Function in the Expression Editor” on page 59 and “Specify the LOOKUPVALUE Function in the Expression Editor” on page 59 for more information.
Specify the LOOKUP Function in the Expression Editor

To use the Expression Editor to enter the LOOKUP function, click the Lookup tab. Double-click on the lookup table name that you want to specify in the function call and click OK.

Display 7.3 Lookup Tab in the Expression Editor

For more information, see “Verify Lookup Keys (Lookup Function)” on page 48.

Specify the LOOKUPVALUE Function in the Expression Editor

To use the Expression Editor to enter the LOOKUPVALUE function:

1. Click the LookupValue tab.
2. Double-click on the lookup table name.
3. Specify the term name or the character string that contains the lookup key value. To specify a term, double-click on the term in the Vocabulary column. To specify a character string as the lookup key value, enter the character string in the field at the top of the LookupValue tab. Enclose the string in quotation marks.
4. (Optional) Click Validate to check the syntax of the expression.
5. Click OK.

For more information, see “Get Lookup Values (LookupValue Function)” on page 48.
Punctuation for Data Values

Values for some data types might need to be enclosed in quotation marks, as shown in the following table. Date and Datetime values must be followed with d and dt, respectively.

Table 7.1 Punctuation Needed for Data Values

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Punctuation Needed</th>
<th>Example</th>
</tr>
</thead>
</table>
| Character | Enclose character strings in either single or double quotation marks. | ='Gold Account'  
            |                                                 | ="Ineligible"  
            |                                                 | ="d'oscail"  |
| Date      | Enter Date values by using the format DDMMMYYYY. Enclose each value in quotation marks followed by d. | ='01SEP2012'd  
            |                                                 | >='31SEP2012'd |
| Datetime  | Enter Datetime values by using the format DDMMMYY:HH:MM:SS. Use 24-hour clock notation. Enclose each value in quotation marks followed by dt. | ='01SEP2012:15:00:00'dt  
            |                                                 | <='31SEP2012:15:00:00'dt |
| Boolean   | Boolean values do not need to be enclosed in quotation marks. Enter only True or False. | =True  
            |                                                 | =False |
Operators for Use in Expressions

The following table lists the operators that you can use in an expression. Do not enter a space between the elements of the operators <=, >=, or ^=. See “SAS Operators in Expressions” in Chapter 6 of SAS Language Reference: Concepts for more information about the operators shown in the table.

Table 7.2 Operators

<table>
<thead>
<tr>
<th>Operator</th>
<th>Definition</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>*</td>
<td>Multiply</td>
<td>0.085 * sales</td>
</tr>
<tr>
<td>/</td>
<td>Divide</td>
<td>amount / 5</td>
</tr>
<tr>
<td>+</td>
<td>Add</td>
<td>num + 3</td>
</tr>
<tr>
<td>–</td>
<td>Subtract</td>
<td>sale - discount</td>
</tr>
<tr>
<td>=</td>
<td>Equal to</td>
<td>= maxTriesAllowed</td>
</tr>
<tr>
<td>+value</td>
<td>Leading plus’</td>
<td>+60</td>
</tr>
<tr>
<td>–value</td>
<td>Leading minus’</td>
<td>–15</td>
</tr>
<tr>
<td>^=</td>
<td>Not equal to</td>
<td>insufficientFunds ^= True</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than</td>
<td>daysLate &gt; 5</td>
</tr>
<tr>
<td>&lt;</td>
<td>Less than</td>
<td>num &lt; 8</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Greater than or equal to</td>
<td>balance &gt;= 1000</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Less than or equal to</td>
<td>balance &lt;= 250</td>
</tr>
<tr>
<td>IN (value-list)</td>
<td>Equal to an item in value-list</td>
<td>in ('high','medium','low')</td>
</tr>
<tr>
<td>NOT IN (value-list)</td>
<td>Not equal to an item in value-list</td>
<td>not in (10,20,30)</td>
</tr>
<tr>
<td>LIKE 'pattern-matching-expression'</td>
<td>If the term’s value matches pattern-matching-expression, the result is true.</td>
<td>like 'HS%PP'</td>
</tr>
<tr>
<td>LIKE ('pattern-matching-expression','pattern-matching-expression')</td>
<td></td>
<td>like ('_976%','_223%')</td>
</tr>
<tr>
<td>expression AND expression</td>
<td>If both expressions are true, the result is true.</td>
<td>dateExpired &gt;= '01AUG2012'd AND dateExpired &lt;= '31AUG2012'd</td>
</tr>
<tr>
<td>expression OR expression</td>
<td>If either expression is true, the result is true.</td>
<td>dateEnrolled &gt;= '01JAN2012' OR member = True</td>
</tr>
</tbody>
</table>

* The application supports leading plus (+) and minus (-) operators in action expressions only.
Using the LIKE Operator

The LIKE operator determines whether the value of a term matches a pattern-matching expression. The syntax of an expression that uses the LIKE operator is as follows:

LIKE 'pattern-matching-expression'
LIKE (pattern-matching-expression'<','pattern-matching-expression'>)

If a term’s value matches the pattern that is specified by pattern-matching-expression, the expression evaluates to true (1). Otherwise, the expression evaluates to false (0).

There are three classes of pattern-matching characters.

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>underscore (_</td>
<td>Matches any single character</td>
</tr>
<tr>
<td>percent sign (%)</td>
<td>Matches any sequence of zero or more characters</td>
</tr>
<tr>
<td>Note: Be aware of the effect of trailing blanks. To match values, you might have to use the TRIM function to remove trailing blanks.</td>
<td></td>
</tr>
<tr>
<td>any other character</td>
<td>Matches that character</td>
</tr>
</tbody>
</table>

The LIKE expression is case sensitive. To search for mixed-case strings, use the UPCASE function to create an upper case version of the term that you want to search. You can use a temporary term to store the results of the UPCASE function. (See Step 8 of “Create New Terms” on page 39.) Use the LIKE operator to search the upper case version of the term.

For example, you can search the term part_Number for mixed-case strings that begin with HS and end with PP by using the two rules shown in the following display.

<table>
<thead>
<tr>
<th>#</th>
<th>Condition Term</th>
<th>Action Term</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>if tempTerm</td>
<td>=upcase(part_Number)</td>
</tr>
<tr>
<td>2</td>
<td>if tempTerm</td>
<td>like('HS%PP')</td>
</tr>
</tbody>
</table>

The following table shows examples of the matches that result if you search a term that could have these values: Smith, Smooth, Smothers, Smart, Smuggle.

<table>
<thead>
<tr>
<th>LIKE Expression Example</th>
<th>Matching Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>like 'Sm%'</td>
<td>Smith, Smooth, Smothers, Smart, Smuggle</td>
</tr>
</tbody>
</table>
LIKE Expression Example | Matching Results
---|---
like '%th' | Smith, Smooth
like 'S__gg%' | Smuggle
like 'S_o' | (no matches)
like 'S_o%' | Smooth, Smothers
like 'S%th' | Smith, Smooth

Using Functions in Expressions

SAS Business Rules Manager supports the following functions in rule expressions:

- LOOKUP and LOOKUPVALUE functions. See “Verify Lookup Keys (Lookup Function)” on page 48 and “Get Lookup Values (LookupValue Function)” on page 48 for more information.
- SAS DS2 functions. For information about these functions, see SAS DS2 Language Reference at http://support.sas.com/documentation/onlinedoc/brm/index.html.

Working with Missing Values

You can enter a missing value for a character string as a null string (""), and you can use a period (.) to designate missing numeric values.

Missing values have a value of false when you use them with logical operators such as AND or OR. For more information, see Chapter 5, “Missing Values,” in SAS Language Reference: Concepts.

You can also use the MISSING function to check for missing values. This function returns a 0 (false) or 1 (true). For more information, see SAS Functions and CALL Routines: Reference.

Terms and Operators Added by SAS Business Rules Manager

As you enter expressions into each cell, SAS Business Rules Manager displays the rule conditions and actions on the Rule Details tab. The operators and term names that are added by SAS Business Rules Manager are also displayed. Remember these rules when you are entering expressions:

- If you do not specify an operator at the beginning of an expression, SAS Business Rules Manager adds an equal sign to the beginning of the expression. For example, if you enter 5+x for an expression, the expression resolves to =5+x.
- When an AND or OR operator is followed immediately by another operator in a condition expression, SAS Business Rules Manager inserts the condition term between the AND or OR operator and the operator that follows it. For example, if you enter >=5 and <10 for myterm, the expression resolves to myterm>=5 and myterm<10. SAS Business Rules Manager inserts the term for top-level AND or OR operators in condition expressions only. It does not insert the term with nested AND or OR operators or in action expressions.
### Examples of Expressions

The following table shows examples of expressions that you can specify.

**Table 7.5  Examples of Expressions**

<table>
<thead>
<tr>
<th>Expression As Entered Into the Decision Table For Term X</th>
<th>Resulting Expression</th>
<th>Valid as a Condition Expression</th>
<th>Valid as an Action Expression</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>( x=5 )</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>=5</td>
<td>( x=5 )</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>+10</td>
<td>( x=x+10 )</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>&quot;mystring&quot;</td>
<td>( x=&quot;mystring&quot; )</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>=term1</td>
<td>( x=term1 )</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>5 or &gt;100</td>
<td>( x=5 ) or ( x&gt;100 )</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>^=5 and ( x&lt;10 )</td>
<td>( x^=5 ) and ( x&lt;10 )</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>^=5 or &gt;=(100/4)</td>
<td>( x^=5 ) or ( x&gt;=(100/4) )</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>in (10,20,30)</td>
<td>( x ) ( \text{IN} ) (10,20,30)</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>not in ('med','high')</td>
<td>( x ) NOT ( \text{IN} ) ('MED','HIGH')</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>rate in ('med','high')</td>
<td>( x = \text{rate in} ) ('med','high')</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>like ('M77__LL%','MA89_LL %')</td>
<td>( x ) LIKE ('M77__LL%','MA89_LL %')</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>&lt;'10JUN2012'd</td>
<td>( x&lt;'10JUN2012'd )</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>&gt;'10JUN2012:17:00:00'd</td>
<td>( x&gt;'10JUN2012:17:00:00'd )</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>=ABS(-10)</td>
<td>( x=\text{ABS}(-10) )</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Expression As Entered Into the Decision Table For Term X</td>
<td>Resulting Expression</td>
<td>Valid as a Condition Expression</td>
<td>Valid as an Action Expression</td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
<td>----------------------</td>
<td>---------------------------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>=True</td>
<td>x=True</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>False</td>
<td>x=False</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>&amp;myMacroVar</td>
<td>x=&amp;myMacroVar</td>
<td>Yes</td>
<td>See Note 2.</td>
</tr>
<tr>
<td>%EVAL(&amp;myMacroVar)</td>
<td>x=%EVAL(&amp;myMacroVar)</td>
<td>Yes</td>
<td>See Note 2.</td>
</tr>
<tr>
<td>term1=5</td>
<td>x=term1=5</td>
<td>Yes</td>
<td>See Note 3.</td>
</tr>
<tr>
<td>term1=3 or term2=5</td>
<td>x=term1=3 or term2=5</td>
<td>Yes</td>
<td>See Note 5.</td>
</tr>
<tr>
<td>5 or (x&gt;10 and &lt;20)</td>
<td></td>
<td>This expression is invalid as both a condition expression and as an action expression. SAS Business Rules Manager does not add column names after nested AND or OR operators.</td>
<td></td>
</tr>
<tr>
<td>&gt;&quot;mystring&quot;</td>
<td></td>
<td>This expression is invalid as both a condition expression and as an action expression. SAS Business Rules Manager checks whether literal types are compatible with the specified operators. Character strings are not compatible with numeric operators.</td>
<td></td>
</tr>
</tbody>
</table>

Notes:

1. Action expressions must be assignment expressions only.

2. SAS Business Rules Manager validates macro functions and variables based only on whether the syntax is correct. It does not check to determine whether a macro function or variable will be accessible when the rule set is executed. Macro support in expressions is controlled by a configuration property in SAS Management Console. See “Support macros in rule expressions” in Chapter 5 of *SAS Business Rules Manager: Administrator's Guide* for more information.

3. This expression is valid. However, it should be avoided. As a condition statement, this expression checks to determine whether both \( x \) and \( \text{term1} \) are equal to 5. The recommended way to enter this expression is \( x = 5 \) and \( \text{term1} = 5 \).

4. As an action expression, this expression becomes a Boolean assignment statement. This expression determines whether \( \text{term1} \) is equal to 5, and if so, assigns a value of 1 (true) to \( x \). If not, it assigns a value of 0 (false) to \( x \).

5. This expression is valid. However, it should be avoided. As a condition statement, this expression checks to determine whether both \( x \) and \( \text{term1} \) are equal to 3 or whether \( \text{term2} \) is equal to 5. The recommended way to enter this expression is \( \text{term1} = 3 \) or \( \text{term2} = 5 \).

6. As an action expression, this expression becomes a Boolean assignment statement. This expression determines whether either \( \text{term1} \) is equal to 3 or \( \text{term2} \) is equal to 5, and if so, assigns a value of 1 (true) to \( x \). If not, it assigns a value of 0 (false) to \( x \).
7. Leading plus (+) and minus (-) operators are valid in action expressions only.

8. As an action expression, this expression becomes a Boolean assignment statement. The expression determines whether rate is equal to high or low, and if so, assigns a value of value of 1 (true) to x. If not, it assigns a value of 0 (false) to x.

**Validate the Expressions in a Rule Set**

When you save a rule set, SAS Business Rules Manager checks whether the syntax in the expressions is valid, and if so, saves the rule set. However, you can click to check the syntax of rule expressions at any time.

SAS Business Rules Manager does not check whether the results produced by the expressions are of the correct data type for the terms to which the expressions apply. Also, when domain values are defined for a term, SAS Business Rules Manager does not check whether the values that are assigned to the term are included in the list of domain values.

**Change the Order of Rules in a Rule Set**

There are two ways to change the order of the rules in a rule set. You can move a single rule to a new position, and SAS Business Rules Manager adjusts the position of the remaining rules in the rule set. Alternatively, you can swap the position of two rules, and SAS Business Rules Manager leaves the remaining rules in their original positions.

**Move a Rule to a New Position in a Rule Set**

*Note:* If you move a rule that uses the ELSE or OR operator to position 1, the operator is changed to IF.

There are two ways to move a rule to a new position:

- Drag the rule to the new position.
- Use the Reorder menu selection.

To use the Reorder menu selection to move a rule:

1. Right-click on the rule that you want to move and select Reorder. The Reorder the Rule window appears.
2. Select the new position number for the rule.
3. Click OK. SAS Business Rules Manager moves the rule to the new position and repositions the remaining rules up or down as needed.

**Swap Two Rules**

*Note:* If you move a rule that uses the ELSE or OR operator to position 1, the operator is changed to IF.
To swap the position of two rules:

1. Right-click on one of the rules that you want to move and select **Swap**. The Swap the Rule window appears.
2. Select the position number for the second rule that you want to move.
3. Click **OK**. SAS Business Rules Manager swaps the positions of the two rules and leaves all other rules in their original positions.

### Copy Rules and Expressions

#### Copy an Entire Rule

To copy and paste an entire rule:

1. Right-click on the rule that you want to copy and select **Copy**.
2. Right-click in the table, and select **Paste**. SAS Business Rules Manager adds the copied rule as the last rule in the rule set. You can then edit or reorder the new rule as needed.

#### Copy Text within a Rule

To copy and paste an expression or part of an expression:

1. Click in the table cell that contains the text that you want to copy.
2. Select the text that you want to copy. To select all of the text in a cell, right-click and select **Select All**.
3. Right-click on the text and select **Copy**.
4. Click in the cell where you want to paste the text and press Ctrl+V.

---

**Delete Rules and Expressions**

**Delete a Rule**

You can delete a rule in one of two ways:

- Click on the rule that you want to delete and click.
- Right-click on the rule and select **Delete Rule**.

**Cut and Paste Text within a Rule**

To cut and paste an expression or part of an expression:

1. Select the cell in the decision table containing the text that you want to cut.
2. Select the text that you want to cut. To select all of the text in a cell, right-click and select **Select All**.
3. Right-click in the cell and select **Cut**.
4. To paste the text, click in the cell where you want to paste the text, and press Ctrl+V.

---

**Edit the Properties of a Rule Set**

To edit the properties of a rule set, open the rule set and select the **Properties** page. You can edit the name and description. If the rule set is empty, you can change the vocabulary that is associated with the rule set. If any rules have been defined for the rule set, you cannot change the vocabulary.

The **Rule Set Logic** section of the properties page displays all of the rules in the rule set and includes the operators and term names that have been added by SAS Business Rules Manager.

---

**Edit the Properties of a Rule**

To edit the properties of a rule:

1. Open the rule set that contains the rule, and select the **Rules** page.
2. Select the rule.
3. Edit the properties as needed. You can edit the name, edit the description, or select whether rule-fired data is recorded for the rule.
4. Click.
Display Usage Information for a Rule Set

To display usage information for a rule set, select the Usage page. Click List to display the terms and lookup tables that are referenced in the rule set and rule flows that use the rule set. Click Diagram to display a diagram showing the rules, rule set, and any rule flows that use the rule set.

Note: The diagram displays information from only the current version of a rule flow. If a published version of a rule flow uses a rule set but the current version of the same rule flow does not, then the rule flow does not appear in the diagram.

If the diagram is too large to fit in the window, you can use the Overview window in the upper left to view different parts of the rule set. Click in the Overview window, and drag the viewport (the white box) to the portion of the rule set that you want to view. You can click on the link anchors in the diagram to expand and collapse parts of the diagram.

If the diagram is not large enough to need the Overview window, you can minimize the window by clicking . If the overview diagram does not match the boundaries of the viewport, you can zoom the diagram to fit the viewport by clicking . However, clicking also resizes the main the diagram.
Managing Rule Set Versions

About Rule Set Versions

The latest version of a rule set is the rule set that has the highest version number. It is also the last version that you saved. You can edit only the latest version of a rule set.

Only one version of a rule set can be unlocked at a time. If you create a new version of a rule set, SAS Business Rules Manager locks the existing latest version before it creates a new latest version.

To edit a rule set, it must be unlocked. You cannot unlock a rule set. To make changes to a rule set that has been locked, you must create a new version of the rule set and make changes to the new version.

Before you can publish a rule flow, all of the rule set versions that are referenced in the rule flow must be locked. Also, a rule flow cannot be published if Use latest is specified for any of the rule set versions.

Set the Displayed Version

On the Versions page, indicates the displayed version. The displayed version is the rule set whose information is displayed on the other pages, such as the Properties and Rules pages. To change the displayed version, select the version that you want to view, and click .

Create a New Version of a Rule Set

Note: When you create a new version of a rule set, SAS Business Rules Manager locks the latest version of the rule set if it is not already locked.

To create a new version of a rule set:

1. Select the Versions page.
2. Click . The Create New Version window appears.
3. Select the version type: Minor or Major. Version numbers follow the format Major.Minor. If you select Major, the number to the left of the period is incremented. If you select Minor, the number to the right of the period is incremented.
4. (Optional) Enter a description.
5. Click OK.

Lock a Rule Set Version

Note: You cannot make changes to a rule set after it has been locked. You cannot unlock a rule set version.

To lock a version of a rule set:

1. Select the Versions page.
2. Select the version of the rule set that you want to lock.
3. Click Lock.

*Note:* You can also lock a version by clicking Lock in the Edit Version window.

**Edit a Version Description**

To edit a version description:
1. Select the Versions page.
2. Select the version of the rule set that you want to edit.
3. Click Edit. The Edit Version window appears.
4. Edit the version description.
5. Click OK or Lock (if you also want to lock the version).

---

**Add Comments to a Rule Set**

You can add new comments or reply to existing comments. To add a new comment:
1. Select the Comments page.
2. Enter a topic title and enter the comment. The topic title is required, and the field for comments does not appear until you enter the topic title.
3. (Optional) Click to add an attachment such as an image or a document.
4. Click Post.

To reply to an existing comment, enter your reply in the field immediately below the topic title for the existing comment, and click Post.

Click to see comments that have been posted by others.

To search for text in the comments, enter text in the search field at the top of the Comments page.

---

**Add Attachments to a Rule Set**

To add an attachment such as a document file or an image file:
1. Select the Attachments page.
2. Click , and select the attachment file.
3. Click .
Copy a Rule Set

You can create a copy of a rule set within the same folder.

To copy a rule set:
2. Right-click on the rule set and select Copy Rule Set. The Copy Rule Set window appears.
3. Enter the name for the new copy of the rule set.
4. (Optional) Enter a description for the rule set.
5. Select the version of the rule set that you want to copy.
6. Click OK.

Move a Rule Set to a Different Folder

You cannot move a rule set if it is open. Close the rule set before trying to move it. To move a rule set to a different folder:
2. Right-click on the rule set, and select Move Rule Set. The Choose a Location window appears.
3. Select the folder where you want to move the rule set to.
4. Click Move.

Delete a Rule Set

Note: You cannot delete a rule set if it is used in a rule flow.

To delete a rule set:
2. Select the rule set and click .
Save a Rule Set

To save changes to a rule set, click on the save button. SAS Business Rules Manager validates the syntax of the expressions and displays an error message if it finds any problems. If SAS Business Rules Manager does not detect any problems with any of the expressions, it saves the rule set. See “Validate the Expressions in a Rule Set” on page 66 for more information.
Chapter 8
Creating and Publishing Rule Flows

Introduction to Rule Flows ...................................................... 76
Simple Rule Flows, Complex Rule Flows, and BY Groups .................. 76
Create a Rule Flow Using the Rule Flow Editor ............................ 76
Create a Rule Flow by Using Discovery Techniques ...................... 78
  About the Discovery Techniques ......................................... 78
  Create a Rule Flow by Using the New Discovery Wizard .............. 78
Open Rule Sets from the Rule Flow Editor ................................ 80
Add Attachments to a Rule Flow ............................................. 80
Add Comments to a Rule Flow .............................................. 81
Change the Order of the Rule Sets ......................................... 81
View the Terms Used in a Rule Flow ....................................... 81
Managing Versions of a Rule Flow ......................................... 82
  About Rule Flow Versions ................................................ 82
  Set the Displayed Version .............................................. 82
  Edit a Version Description ............................................ 82
Rename a Rule Flow .......................................................... 82
Copy a Rule Flow ............................................................. 82
Move a Rule Flow to a Different Folder .................................... 83
Remove a Rule Set from a Rule Flow ...................................... 83
Delete a Rule Flow ........................................................... 83
Testing a Rule Flow ........................................................... 83
  Input Data for Rule Flow Tests .......................................... 84
  Create and Run a New Rule Flow Test ................................ 84
  Run a Rule Flow Test ..................................................... 84
  Copy a Rule Flow Test ................................................... 85
  Edit a Rule Flow Test ..................................................... 85
  Delete a Rule Flow Test .................................................. 85
  Specify Preprocessing Code ............................................. 85
  View Rule Flow Test Results ........................................... 85
Publish a Rule Flow .......................................................... 86
Display Publish Information for Rule Flows ................................ 87
Deploy a Rule Flow as a Stored Process .................................... 87
Introduction to Rule Flows

A business rule flow is a logical collection of multiple rule sets that define multiple conditions and actions. In general, the rule sets in a rule flow are executed in the order in which they are defined in the rule flow. However, with complex rule flows, certain sections of rule sets are usually executed more times than others. See “Simple Rule Flows, Complex Rule Flows, and BY Groups” on page 76 for more information.

After you publish a rule flow to the SAS Metadata Server, other applications can deploy the published rule flows as SAS programs and services. These programs and services process input data, which contains conditions, in order to create output data, which contains actions. The terms used in the rule flows are mapped to table columns by the applications that use the published rule flows within metadata.

Simple Rule Flows, Complex Rule Flows, and BY Groups

There are two general types of rule flows, simple and complex. A simple rule flow has a single group of rule sets. All of the rule sets are run and output is generated for each input record.

A complex rule flow has at least three sections: Initial, Main, and Final. Rule sets in the Initial section are run only when the first input record is processed. Rule sets in the Main section are run for each input record. Rule sets in the Final section are run after the last input record has been processed by the rule sets in the Main section.

For complex rule flows, you can specify BY-group terms. If you specify BY-group terms, then SAS Business Rules Manager sorts the input data by those terms, and results are calculated for each group of input records that have the same value for all of the terms. Output is generated for each BY group instead of for each input record.

Also, if you specify BY-group terms, SAS Business Rules Manager adds two new sections to the rule flow, Group Start and Group End. The rules sets in these sections are run with the first and last input record in each BY group.

Note: You are not required to enter rule sets into all of the sections in a rule flow.

Create a Rule Flow Using the Rule Flow Editor

To create a rule flow:
2. Right-click on the folder where you want to create the new rule flow, and select New Rule Flow. Alternatively, select the folder where you want to add the new rule flow, click, and select New Rule Flow. The New Rule Flow window appears.
3. Enter a name for the new rule flow. Rule flow names are limited to 32 characters and can contain any character except forward slash (/), backslash (\), left brace ({), right brace (}), colon (:), and question mark (?).
4. (Optional) Enter a description for the new rule flow. Descriptions are limited to 256 characters.

5. (Optional) Select **Create output only for records that fire rules** to limit the output of the rule flow. By default, all output records are written to the output data set. However, for some types of applications, only the output records for which at least one rule has fired are of interest. Limiting output is useful for applications that detect outliers, such as applications that detect fraud.

6. Click **Create**. SAS Business Rules Manager creates a new rule flow and opens the rule flow editor. By default, the **Properties** page is displayed.

7. Select the **Rule Sets** page.

8. (Optional) Select **Complex Rule Flow** from the menu in the toolbar. SAS Business Rules Manager adds Initial and Final sections to the rule flow table. The rules in these sections are run at the start and end of the rule flow.

9. Add rule sets to the rule flow. Right-click on a rule set in the **Rule Sets** pane, and select the appropriate **Add To Section** option. The options that are available depend on whether you are creating a simple or complex rule flow.

   **Note:** A rule flow can use only rule sets that are defined for the same vocabulary. After the first rule set is added to the rule flow, the vocabulary for the rule flow is established. Only the rule sets that use the same vocabulary are displayed in the Resources pane.

   **Note:** A rule set can be added to the same rule flow only once.

10. (Optional) If you selected **Complex Rule Flow**, you can specify BY-group terms. With BY-group processing, all of the input records that have the same values for the BY-group terms are processed before output is generated. One output record is written for each group.

   a. Click **Create** and select the BY-group terms. SAS Business Rules Manager adds Group Start and Group End sections to the table. The rules in these groups are run at the start and end of each BY group.

   b. (Optional) Add the rule sets that you want in the Group Start and Group End sections of the table.

11. (Optional) Select the version of each rule set. If the version is **Use latest**, then the most recently saved version of the rule set is always used when it is run. Specifying **Use latest** for the version is useful during rule flow development and testing. However, before you can publish a rule flow, all of the rule set versions that are referenced in the rule flow must be locked. Also, a rule flow cannot be published if **Use latest** is specified for any of the rule set versions.

12. (Optional) Reorder the rule sets. To move a rule set, select the rule set, and click **Create** or **Insert** to move it to a different row in the table. To move a rule set to a different section (Initial, Main, and so on), you must remove the rule set, and then add it to the other section. To remove a rule set, select the rule set and click **Delete**.
13. (Optional) Clear the check boxes in the Run column for any rules or sections that you do not want to be run the next time the rule flow is run. Selectively running certain rule sets is useful during rule flow development and testing.

14. Click the save button to save the rule flow.

---

### Create a Rule Flow by Using Discovery Techniques

**About the Discovery Techniques**

With the New Discovery wizard, you can use discovery techniques to generate business rule data and import that data into SAS Business Rules Manager. The discovery techniques that you can select from are:

- **Decision Tree**
  Decision Tree analysis produces a tree-like diagram in which each branch of the tree represents a possible decision or event. The tree structure shows how one choice leads to the next. Each branch represents a mutually exclusive option. Decision trees are often used for data segmentation or prediction modeling. You can create decision trees to classify observations based on the values of nominal, binary, or ordinal targets or to predict outcomes for interval targets.

- **Scorecard**
  Scorecards provide a quantitative score of the odds that a customer will display a defined behavior such as respond positively to a campaign, make a purchase, default on a loan, and so on. The higher the score, the more likely the defined behavior will occur. The SAS Business Rules Manager Scorecard uses the Weight of Evidence technique to generate scores.

- **Recency Frequency Monetary (RFM)**
  RFM is a technique that is used to identify existing customers who are most likely to respond to a new campaign or product offer. RFM analysis looks at when a customer last placed an order or bought something, how often the customer makes a purchase, and how much money they spend. Customers are assigned scores based on these factors.

- **Market Baskets**
  Market Basket analysis is used to predict items that are most likely to be purchased together. Market Basket analysis can be used to predict what items a customer is likely to buy.

**Create a Rule Flow by Using the New Discovery Wizard**

When you run the New Discovery wizard, it generates a vocabulary, as many rule sets as are needed, and a rule flow using the discovery technique that you select.

To create a rule flow using the New Discovery wizard:


2. Right-click on the folder where you want to create the new rule flow, and select New Rule Flow. Alternatively, select the folder where you want to add the new rule flow, click the save button, and select New Rule Flow. The New Rule Flow window appears.
3. Enter a name for the new rule flow. Rule flow names are limited to 32 characters and can contain any character except forward slash (/), backslash (\), left brace (lbrace), right brace (rbrace), colon (:), and question mark (?).

   *Note:* The name that you enter is used for both the vocabulary and the rule flow. Vocabulary names must be unique within the rules database.

4. (Optional) Enter a description for the new rule flow. Descriptions are limited to 256 characters.

5. (Optional) Select **Create output only for records that fire rules** to limit the output of the rule flow. By default, all output records are written to the output data set. However, for some types of applications, only the output records for which at least one rule has fired are of interest. Limiting output is useful for applications that detect outliers, such as applications that detect fraud.

6. Select **Use discovery techniques to generate rules**.

7. Click **Create**. SAS Business Rules Manager opens the New Discovery window.

8. Select the **Discovery technique**. The techniques that are available depend on the products that are licensed at your site. The Recency Frequency Monetary (RFM) technique is available with Base SAS. The Decision Tree and Scorecard techniques require a SAS/STAT license. The Market Baskets technique requires a SAS Enterprise Miner license.

9. Select the **Data source** that you want to use for the discovery analysis.

10. Select the setup options for the discovery technique, and click **Next**. The setup options depend on the technique. See Table 8.1 on page 80.

11. Select the terms required for the discovery technique. See Table 8.1.

12. Click **Run** to run the analysis. SAS Business Rules Manager displays the rule sets that were generated by the analysis.

13. Click **Import** to import the data. If the data was imported successfully, SAS Business Rules Manager displays a confirmation message telling you what data was imported and which folder it was added to.

14. (Optional) Click **Rule_generation_log** and **Rule_import_log** to download the log files to your local machine. The log file name is `RuleFlowName_generation.log`, and the import log file name is `RuleFlowName_import.log`. If rules can not be generated or the import process fails, the log files contain detailed error messages.

15. Click **Close** to close the New Discovery wizard. SAS Business Rules Manager opens the new rule flow in the rule flow editor and displays the **Rule Sets** page.

After using the New Discovery wizard to generate and import a new rule flow, all of the rule set versions in the rule flow will be unlocked, latest versions. To publish the rule flow, you must lock the rule sets, and then select the locked version in the rule flow editor. See “Lock a Rule Set Version” on page 70 and Step 11 in “Create a Rule Flow Using the Rule Flow Editor” on page 76 for more information.
## Table 8.1 Setup Options and Terms For Discovery Techniques

<table>
<thead>
<tr>
<th>Discovery Technique</th>
<th>Setup Variables</th>
<th>Terms</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decision Tree</td>
<td><strong>Maximum number of rules</strong>: Select the maximum number of rules that you want to be generated from the discovery analysis.</td>
<td>Select the terms whose values you want to predict, and click to move them to the Actions list.</td>
</tr>
</tbody>
</table>
| Scorecard           | **Minimum points**: The scorecard points are scaled with this option as the minimum value. You can specify any non-negative integer.  
**Maximum points**: The scorecard points are scaled with this option as the maximum value. You can specify any positive integer that is greater than the Minimum points value. | **Target variable**: specifies the variable that you are modeling. The variable must have exactly two discrete values such as 0 and 1 or True and False.  
**Target category**: specifies how the values of the target variable are mapped. The scorecard points are scaled to the likelihood of the two target variable values based on the sort order. Select **High** to indicate that the highest lexical value of the target variable is mapped to the Maximum points value. Select **Low** to indicate that the lowest lexical value of the target variable is mapped to the Maximum points value. |
| Recency Frequency Monetary | Select the binning method.  
**Independent**: Simple ranks are assigned to recency, frequency, and monetary values. The three ranks are assigned independently.  
**Nested**: A simple rank is assigned to recency values. Within each recency rank, customers are then assigned a frequency rank. Within each frequency rank, customer are assigned a monetary rank. | **Customer ID**: specifies a numeric or character term that uniquely identifies a customer.  
**Transaction date**: specifies the transaction date.  
**Transaction amount**: specifies the transaction amount. |
| Market Baskets      | **Maximum number of rules**: Select the maximum number of rules that you want to be generated from the discovery analysis. | **ID**: specifies the customer ID.  
**Item**: specifies the item that was purchased. |

---

### Open Rule Sets from the Rule Flow Editor

You can open a rule flow and some or all of its rule sets in the same layout. In the rule flow editor, either double-click on the rule sets that you want to open, or select the rule sets and click.[link]

---

### Add Attachments to a Rule Flow

To add an attachment such as a document file or an image file:

1. Select the **Attachments** page.
2. Click +, and select the attachment file.
3. Click −.

Note: You can delete an attachment by selecting the attachment and clicking −.

---

### Add Comments to a Rule Flow

You can add new comments or reply to existing comments. To add a new comment:

1. Select the Comments page.
2. Enter a topic title and enter the comment. The topic title is required, and the field for comments does not appear until you enter the topic title.
3. (Optional) Click to add an attachment such as an image or a document.
4. Click Post.

To reply to an existing comment, enter your reply in the field immediately below the topic title for the existing comment, and click Post.

Click to see comments that have been posted by others.

To search for text in the comments, enter text in the search field at the top of the Comments page.

---

### Change the Order of the Rule Sets

You can change the order of rule sets within the same section only (Initial, Main, Final, and so on). To reorder the rule sets in a rule flow, select the rule set that you want to move, and click ↑ or ↓.

---

### View the Terms Used in a Rule Flow

To view the input or output terms that are used in all of the rule sets in a rule flow, open the rule flow, and select the Variables page.

To view all of the terms that are used in single rule set, open the rule flow, select the rule set, and click ＃.

Note: This icon is unavailable if you have made editing changes to the rule flow. You must save the changes to the rule flow before you click on this icon.
Managing Versions of a Rule Flow

About Rule Flow Versions

When you publish the current version of a rule flow, that version is locked and assigned a version number. A new current version is created. You cannot unlock a rule flow.

Before you can publish a rule flow, all of the rule set versions that are referenced in the rule flow must be locked. Also, a rule flow cannot be published if Use latest is specified for any of the rule set versions.

Set the Displayed Version

On the Versions page, indicates the displayed version. The displayed version is the rule flow whose information is displayed on the other pages, such as the Properties and Rule Sets pages. To change the displayed version, select the version that you want to view, and click .

Edit a Version Description

To edit a version description:

1. Select the Versions page.
2. Select the version of the rule that you want to lock.
3. Click . The Edit Version window appears.
4. Edit the version description.
5. Click OK.

Rename a Rule Flow

To rename a rule flow:

1. Close the rule flow if it is open. You cannot rename a rule flow if it is open.
2. Right-click on the rule flow and select Rename.
3. Change the name and click OK.

Copy a Rule Flow

You can create a copy of a rule flow within the same folder.
To copy a rule flow:
1. Right-click on the rule flow, and select **Copy Rule Flow**. The Copy Rule Flow window appears.
2. Enter a name for the new copy of the rule flow.
3. (Optional) Enter a description for the rule flow.
4. (Optional) Select **Create output only for records that fire rules** to limit the output of the rule flow. For some types of applications, only the output records for which at least one rule has fired are of interest. Limiting output is useful for applications that detect outliers, such as applications that detect fraud.
5. Click **OK**.

---

**Move a Rule Flow to a Different Folder**

To move a rule flow to a different folder:
1. Close the rule flow if it is open. You cannot move a rule flow that is open.
2. Right-click on the rule flow and select **Move Rule Flow**. The Choose a Location window appears.
3. Select the folder where you want to move the rule flow to.
4. Click **Move**.

---

**Remove a Rule Set from a Rule Flow**

To remove a rule set from a rule flow, open the rule flow, select the rule set, and click **X**. Alternatively, you can right-click on the rule set and select **Remove**.

---

**Delete a Rule Flow**

*Note:* You cannot delete a rule flow if it has been published.

To delete a rule flow, select the rule flow and click **Trash Can**. Alternatively, you can right-click on the rule flow and select **Delete**.

---

**Testing a Rule Flow**

You can test a rule flow before you publish it. If necessary, you can specify initialization or setup code that you want to run before the rule flow is run. SAS Business Rules Manager reports rule flow results and test data such as rule-fired data. SAS Business Rules Manager saves the test results from the last time a test was run.
**Input Data for Rule Flow Tests**

SAS Business Rules Manager expects the input data for the rule flow test to already exist and to be defined as a data table. See Chapter 3, “Managing Data Tables,” on page 25 for information on defining data tables. Your user ID must have permission to access the data.

**Create and Run a New Rule Flow Test**

To test a rule flow:

1. Open the rule flow that you want to test.
2. Select the Tests page.
3. Click to add a new test. The Add a New Test window appears.
4. Enter a name for the new test. Test names are limited to 30 characters.
5. (Optional) Enter a description for the test.
6. Select the data source that contains the input data for the test, and click Next.
7. Map the terms in the rule flow to columns in the input data set. If you click Map terms, the application automatically maps as many terms as possible. You can also map terms by manually selecting an input column for each rule flow term.
8. Click Next.
9. (Optional) Enter any SAS code, such as initialization code or setup code, that you want to run before the rule flow is run. See “Specify Preprocessing Code” on page 85 for more information.
10. Click Run to run the test, or click Save to save it without running it.

If the test completes successfully, the status on the Tests tab changes to . SAS Business Rules Manager displays the Results tab on which you can view the output of the rule flow, analyze the rule-fired data, and view the SAS code that was generated and run by SAS Business Rules Manager, in addition to other information. See “View Rule Flow Test Results” on page 85 for more information.

Rule flow tests are associated with the rule flow version. After a test completes, the test version is displayed on the Tests page.

**Run a Rule Flow Test**

To run a rule flow test:

1. Open the rule flow that you want to test.
2. Select the Tests page.
3. Select the test that you want to run and click .
Copy a Rule Flow Test

To copy a test:
1. Open the rule flow.
2. Select the Tests page.
3. Select the test that you want to copy and click 

Edit a Rule Flow Test

To edit a rule flow test:
1. Open the rule flow.
2. Select the Tests page.
3. Select the test that you want to edit and click 

Delete a Rule Flow Test

To delete a rule flow test:
1. Open the rule flow.
2. Select the Tests page.
3. Select the test that you want to delete and click 

Specify Preprocessing Code

To specify code that you want to run before the rule flow is executed, enter the code on the Preprocessing step in the Add a New Test window.

You can use the &BRMPrimaryTransactionDTTM macro variable to specify a value that is recorded in the TRANSACTION_DTTM field in the rule-fired data. Assigning a value to this field helps you determine the exact input record that caused a rule to execute. You can assign a term or a SAS expression to this macro variable. See “Rule-Fired Table Fields” on page 105 for information about fields in the rule-fired data.

The &BRMPrimaryTransactionDTTM macro variable must resolve to a SAS Datetime value. If you assign a term to this macro variable, the term must be of the type Datetime. Expressions must resolve to a SAS Datetime value. For example, you can use the DATETIME function to assign the current date and time to this macro variable as follows:

\%
let brmPrimaryTransactionDTTM=\datetime();

View Rule Flow Test Results

When you test a rule flow, SAS Business Rules Manager displays the output of the rule flow together with other information on the on the Results tab.
There are several sections to the results.

**Input Table**
the data table that was specified as input for the test.

**Output Table**
the output table produced by the rule flow and detailed information about the columns in the table. Click above the output table to filter the rows that are displayed.

**Rules Fired Analysis**
tables that enable you to determine which rules fired for specific output records. Select a record in the **Output Records** table, and SAS Business Rules Manager displays the rules that fired for that record in the bottom table.

**Plot**
a graph that shows the number of times that each rule set was executed.

**Code**
the SAS code that was generated and run by SAS Business Rules Manager when the test was submitted.

**Log**
the SAS log that was generated when the code was run.

**Properties**
the date the test was last run, and the location information for the output library, output table, and rule-fired table, in addition to other information.

**Terms**
the terms that are used in the rule flow and the input table columns that they are mapped to.

**Preprocessing**
the preprocessing code that was specified when the test was set up.

---

**Publish a Rule Flow**

Publishing is the process of writing a business rule flow to the content server. After you publish a rule flow to the content server, other applications can use it.

When you publish the current version of a rule flow, that version of the rule flow is locked and cannot be unlocked. For more information, see “Managing Versions of a Rule Flow” on page 82.

*Note:* Before you can publish a rule flow, all of the rule set versions that are referenced in the rule flow must be locked. Also, a rule flow cannot be published if **Use latest** is specified for any of the rule set versions.

1. Open the rule flow.

2. If the rule flow contains changes that have not been saved, click . You cannot publish a rule flow if it contains changes that have not been saved.

3. Click . The Choose a Location window appears.

4. Select the location where you want to publish the rule flow.

*Note:* This window lists all of the objects that are defined in the SAS metadata folders. To limit the list to folders only, select the **Show folders only** check box.
Deploy a Rule Flow as a Stored Process

A stored process is a SAS program that is stored on a server and defined in metadata, and which can be executed as requested by client applications. When you deploy a rule flow as a stored process, the rule flow is made available as a stored process on the SAS Stored Process Server.

Before you can deploy a rule flow, all of the rule set versions that are referenced in the rule flow must be locked. Also, a rule flow cannot be deployed if Use latest is specified for any of the rule set versions.

1. Open the rule flow.
2. If the rule flow contains changes that have not been saved, click . You cannot deploy a rule flow if it contains changes that have not been saved.
3. Click . The Choose a Location window appears.
4. Select the location where you want to deploy the rule flow.
   TIP This window lists all of the objects that are defined in the SAS metadata folders. To limit the list to only folders, select the Show folders only check box.
   Note: To create a new subfolder in the Choose a Location window, click .
5. Click OK.

For more information about stored processes, see SAS Stored Processes: Developer's Guide.
Part 3

Using SAS Workflow with SAS Business Rules Manager

Chapter 9
Starting a Workflow and Working with Tasks ......................... 91

Chapter 10
Managing Workflows ...................................................... 95
Chapter 9
Starting a Workflow and Working with Tasks

Overview of Using Workflows

SAS Business Rules Manager uses the Workflows and My Tasks category views to use SAS Workflow. A workflow is a copy of a workflow template. A workflow can be used to track the progress of objects, such as rule flows at the version level. An authorized user can use SAS Workflow Studio to define workflow templates and to make them available to SAS Business Rules Manager for use. Workflow templates contain the set of tasks, participants, policies, statuses, and data objects that comprise a business task. The status that you select when completing a task determines the next task in the workflow.

All users have access to view the My Tasks category view. Only administrators can view the Workflows category view.

For more information about user permissions, see SAS Business Rules Manager: Administrator's Guide

Start a New Workflow

When you start a new workflow, it is associated with the selected version of a rule flow. For a specific version, only one workflow can be in progress at a time. To start another workflow for the same version, you must first complete the in-progress workflow, or terminate the in-progress workflow process. A workflow can be started only for a version of a rule flow that is in the state of Current.

1. Open a rule flow.
2. Click in the right-side of the object toolbar.
3. Enter a name for the new workflow.
4. (Optional) Enter a description for the workflow.
5. Select a template from which to create the workflow.
6. Click Start.

For more information, see Chapter 10, “Managing Workflows,” on page 95.

**Working with Workflow Tasks**

The My Tasks category view displays the tasks for In progress workflows that you have been assigned as a potential owner or that have been claimed by you.

From the My Tasks category view, you can perform the following:
- open a task that pertains to the associated object
- claim and open a task that pertains to the associated rule flow
- claim a task
- release a task
- view the task details
To complete a task:

1. Select a task and click in order to open the associated rule flow and perform the task.
2. Navigate through the rule flow’s pages to perform the steps for the current task.
3. Click 💬.
4. Select an action to take for the selected task. The actions that are available are the status values for the task in the workflow.
5. Click Done. The workflow process continues to the next task.

Note: Only a business administrator who has access to the Workflows category can release a task that has been claimed by another participant. For more information, see “Release a Task” on page 100.
Overview of Managing Workflows

SAS Business Rules Manager can be used to manage workflows. You can create new workflows, view workflows, and interact with tasks that are associated with a workflow. If a user is assigned to the workflow role of business administrator, they can influence the progress of a task by actions such as assigning a task, or releasing the task that is claimed by another user, as well as specify values for properties to share information with other users. After the workflow templates are made available, an application administrator can set the object mappings using the Workflows category view. Each workflow consists of tasks.

Select Workflows to view a list of the available workflows.
**Viewing Workflows**

Only a user who is able to access the Workflows category view can manage workflows. Other users can view the list of tasks from the workflow task drop-down list that is accessible from the rule flow toolbar. If a user is the actual owner of a task, or assigned as a potential owner of a task, they can view the workflow diagram and tasks that in the My Tasks category view. Workflows are associated with a rule flow at the version-level.

From the Workflows category view, you can perform the following actions:

- set mappings
- migrate workflows from a previous version
- terminate a workflow process

To view detailed information for a workflow, double-click a workflow name. The list of tasks, the task status, and who the task is claimed by are displayed. You can then view the properties and participants that are associated with a task by selecting a task. The workflow diagram is also displayed with the current status of the workflow and its tasks.

For more information, see “Working with Workflow Participants” on page 98.

---

**Migrate Workflows**

If you have migrated from a previous version of SAS Business Rules Manager, you must migrate the workflows. All active (in progress) or completed workflows can be migrated. Terminated workflows are not migrated. The workflows must also be associated with a valid UUID for a version of a rule flow. Only workflows that are associated with a rule flow that still exists are migrated. If the rule flow was deleted, the associated workflow is not migrated.

Select Workflows ➔ Actions ➔ Migrate from Previous Version. The list of workflows is refreshed after the workflows are migrated.

---

**Set Mappings**

There are two different types of workflow templates that can be configured for use with SAS Business Rules Manager. Workflows templates that contain tasks that are configured with an approval status are considered an approval workflow. Workflow templates that do not contain tasks with an approval status are considered a standard workflow. The rule flows object can only be associated with an approval type. After you define your workflow template, save, and activate it using SAS Workflow Studio. You must specify the templates to map to each type of object. This enables you to start a new workflow using one of the templates that are associated with the specific object.

1. Select Actions ➔ Set Mappings. The Set Mappings window appears.
2. Select an object and then select one or more templates to map to the object.

3. Select a type for each template. The types of templates that are available are Approval and Standard.

4. Select the default template for the object.

5. Click OK.

---

**Working with Workflow Participants**

From the Workflow details view you can access the properties and participants that are associated with a task by selecting a task. If you are a user that is associated with the workflow role of business administrator, you can assign or remove participants, and release tasks that have been claimed by another user.

**Assign Participants to Tasks**

Default participants might have been assigned already to tasks when a workflow definition was created.

To assign an additional participant to a task:

1. From the Workflows category view, double-click a workflow. The Workflow details view is displayed.
2. Select a task, and then click in the Participants pane. The Assign a Participant window appears.

3. Select one of the identity types: user, group, or role.

4. Enter part of the user, group, or role name, and click .

   Note: If you do not enter part of the name, all of the names for the selected identity type are displayed.

5. Select a workflow role for the participant.

   Here are the workflow roles that you can assign to participants for a workflow task:

   • Business administrator: a participant who can influence the progress of a task by actions such as assigning a task, or releasing the task claimed by another user.

   • Potential owner: a participant who can claim a task in a workflow process and who becomes the actual owner of a task.

6. Click OK. The new participant is added to the list in the Participants pane.
**Remove Participants from a Task**

To remove a participant from a task:

1. From the Workflows category view, double-click a workflow name.
2. Select a task, and then select a participant from the Participants pane.

   *Note:* You cannot remove a participant who is associated with the workflow roles of business administrator or actual owner.
3. Click \[ \] . A message is displayed asking if you are sure that you want to remove the participant from the task.
4. Click Yes. The user is removed from the list in the Participants pane.

**Release a Task**

An authorized user with the capability to access the Workflows category view can release a task that has been claimed by a workflow participant. The name of the actual owner is displayed in the Participants pane.

To release a task:

1. From the Workflows category view, double-click a workflow name. The Workflow details view is displayed.
2. Select a task name, and click \[ \]. The Claimed By value for the selected task is cleared.

**Edit Task Properties**

A task can contain properties. Properties that are editable display a triangular icon in the bottom right corner of the property value in the data grid.

To edit the properties for a task:

1. From the Workflows category view, open a workflow, and select a task. The properties that are associated with the task are displayed to the right in the Properties pane.
2. Click on the property value, and then enter a value or change the existing value.
3. To save the changes to the properties, click \[ \].

   If you do not want to save the changes to the properties, click \[ \].

**Terminate a Workflow**

When you terminate a workflow process, all tasks that have not yet been completed are changed to a state of Terminated. After you terminate a workflow process, it cannot be restarted. However, you can start a new workflow for the same version.
To terminate a workflow:

1. From the Workflows category view, select a workflow name and click 📋.
2. Click **Yes** to terminate the selected workflow.
Part 4

Appendix

Appendix 1
Rule-Fired Table Fields .................................................. 105
Each record in the rule-fired table contains the following fields:

**RULE_ACTION_FIRE_ID**
the unique identification string that is generated for the rule each time it is executed.

**RULE_SET_SK**
the identification number of the rule set.

**RULE_SET_NM**
the name of the rule set.

**RULE_SK**
the identification number of the rule.

**RULE_NM**
the name of the rule.

**RULE_FLOW_SK**
the identification number of the rule flow.

**RULE_FLOW_NM**
the name of the rule flow.

**RULE_FIRE_DTTM**
the date and time that the rule was run.

**DEPLMT_EXECUTION_ID**
the identification string of the specific instance of the rule flow that was executed.

**ENTITY_PRIMARY_KEY**
the value of the term that was specified with the &BRMPrimaryEntityKey macro variable in the test preprocessing code.

**TRANSACTION_DTTM**
the value of the term that was specified with the &BRMPrimaryTransactionDTTM macro variable in the test preprocessing code. The TRANSACTION_DTTM is the value of the Datetime term for the record that was being processed when the rule was executed.

See “Specify Preprocessing Code” on page 85 for information about the &BRMPrimaryTransactionDTTM variable.
**business entity**
an object in your business domain. An entity has one or more terms, which are attributes of an entity. For example, the business entity could be the customer, and the associated terms could be the name, account number, account type, and so on.

**business rule**
a statement of business logic that specifies conditions to be evaluated and actions to be taken if those conditions are satisfied.

**business rule flow package**
a business rule flow that has been saved to an XML file.

**business rule service**
a business rule flow that has been implemented as a web service.

**data object**
an object that holds the business data that is required to execute workflow tasks.

**decision tree**
a set of rules that split data into a hierarchy of successive segments, and which can be used, for example, to determine a single result or appropriate action. The leaves represent an optimal segmentation of the branches above them according to a statistical measure.

**key**
See “lookup key”.

**library reference**
See “libref”.

**libref**
a SAS name that is associated with the location of a SAS library. For example, in the name MYLIB.MYFILE, MYLIB is the libref, and MYFILE is a file in the SAS library.

**lookup key**
a value that uniquely identifies a specific record and its order among other records in a database or table.
lookup table
a table that contains lookup keys and their corresponding values.

lookup value
the value that is associated with a lookup key in a lookup table.

metadata
descriptive data about data that is stored and managed in a database, in order to facilitate access to captured and archived data for further use.

policy
a workflow element that associates event-driven logic with a task or subflow. Policies are usually triggered automatically by an event such as a status change or a timer event.

publish
to register a business rule flow in a SAS metadata repository.

rule
See “business rule”.

rule flow
a logical collection of multiple rule sets that define multiple conditions and actions. Rule flows can be tested and deployed as SAS programs and services that process input data, which contain conditions, in order to create output data, which contain actions.

rule set
a logical group of business rules.

SAS Content Server
a server that stores digital content (such as documents, reports, and images) that is created and used by SAS client applications. To interact with the server, clients use WebDAV-based protocols for access, versioning, collaboration, security, and searching.

SAS Metadata Repository
a container for metadata that is managed by the SAS Metadata Server.

SAS Metadata Server
a multi-user server that enables users to read metadata from or write metadata to one or more SAS Metadata Repositories.

swimlane
a workflow diagram element that enables you to group tasks that are assigned to the same participant.

task
a workflow element that associates executable logic with an event such as a status change or timer event.

task status
the outcome of a task in a workflow. The status of a task (for example, Started, Canceled, Approved) is typically used to trigger the next task.
**term**
an attribute of a business entity. Terms might or might not have a list of valid values. For example, a customer entity might have terms such as account type or age. Valid values for the account type term might include "commercial" or "personal."

**vocabulary**
the set of business entities that define your business domain.

**workflow**
a series of tasks, together with the participants and the logic that is required to execute the tasks. A workflow includes policies, status values, and data objects.

**workflow definition**
a workflow template that has been uploaded to the server and activated. Workflow definitions are used by the SAS Workflow Engine to create new workflow instances.

**workflow instance**
a workflow that is running in the SAS Workflow Engine. After a workflow template is uploaded to the server and activated, client applications can use the template to create and run a new copy of the workflow definition. Each new copy is a workflow instance.

**workflow template**
a model of a workflow that has been saved to an XML file.
Glossary
Index

**Special Characters**
- &BRMPrimaryEntityKey macro variable 85, 105
- &BRMPrimaryTransactionDTTM macro variable 85, 105

**A**
- action expressions 52
- alert notifications
  - configuring for workflows 8
- attachments
  - adding to a rule set 71

**B**
- Boolean values
  - contrast with Character values 38
  - entering 60
- business rules
  - changing name or description 68
  - conditional processing 56
  - creating 54
  - deleting rules 68
  - deleting text in a rule 68
  - description of 52
  - example 52
  - executing 10
  - reordering in a rule set 66
  - swapping positions of two rules 66
- BY groups 76

**C**
- category view 4
- category view, managing columns colors, application window preference 8
- comments
  - adding to a rule set 71
- condition expressions 52
- conditional processing 56
- copying
  - rules 67
  - text within a rule 67

**D**
- Date values, entering 60
- Datetime values, entering 60
- decision table 6
- domain values 41

**E**
- ELSE operator 56
- entities
  - creating 39
  - deleting 42
  - description of 37
  - editing 42
- excluding terms from input data 39
- excluding terms from output data 39
- Expression Editor 57
- expressions
  - action, description of 52
  - condition, description of 52
  - deleting 68
  - entering data values in 60
  - examples 64
  - missing values in 63
- operators added by SAS Business Rules Manager 63
- operators for use in 61
- terms added by SAS Business Rules Manager 63
- using functions in 63
- validating 66

**F**
- Final, rule flow section 76
- focus indicator, preference 8
- folders
  - about 33
  - creating 33
  - creating top-level 33
  - deleting 34
  - moving 34
  - renaming 34
- functions in expressions 63
Index

G
Group End, rule flow section 76
Group Start, rule flow section 76

I
IF operator 56
Init, rule flow section 76

L
locale, preference 7
lock version
rule set 70
Lookup function 48
LOOKUP function
in the Expression Editor 59
lookup key 46
verifying 48
lookup table
creating 46
deleting 47
description 45
refreshing 47
lookup value 46
retrieving 48
LookupValue function 48
LOOKUPVALUE function
in the Expression Editor 59

M
macro variables
&BRMPrimaryEntityKey 85, 105
&BRMPrimaryTransactionDTTM 85, 105
Main, rule flow section 76
manage
workflows 95
missing values in expressions 63

N
navigation pane 4

O
operators 56
operators in expressions 61
OR operator 56
order of rules, changing 66

P
preferences
global 7
SAS Business Rules Manager
preferences 8
SAS Preferences Manager 8
setting 7
publishing rule flows 86

R
rule flows
BY groups 76
changing name or description 82
complex 76
copying 82
creating 76
deleting rule sets from 83
deleting 83
description of 76
displaying rule sets used in 80
moving 83
publishing 86
reordering rule sets in 81
sections, in complex rule flows 76
simple 76
viewing terms in 81
rule flows, running a test 84
rule flows, testing 83
input data 84
preprocessing code 85
viewing test results 85
rule sets
changing name or description 68
changing rule order 66
copying 72
creating 53
deleting 72
deleting from rule flows 83
description of 53
moving 72
opening multiple 80
reordering in rule flows 81
saving 73
usage information 69
validating 66
versions 70
rules
See business rules
rules database, basic steps for creating 10

S
SAS Business Rules Manager
category view 4
features 3
interface 4
navigation pane 4
tile pane 4
SAS Preferences Manager 8
string values, entering 60

T
terms
  creating 39
  deleting 42
  description of 38
  domain values 41
  editing 42
  excluding terms from input data 39
  excluding terms from output data 39
  temporary 39
  used in rule flows 81
theme, preference 8
tile pane 4
tutorial
  make files available 12
tutorials
  define data sources 13
  sign in 13

U
usage information, rule sets 69

V
validating expressions 66
versions
  rule flow, description 82
  rule flow, displayed version 82
  rule set 70
rule set, creating 70
rule set, description 71
rule set, displayed version 70
rule set, latest version 70
rule set, locking 70
vocabularies
  creating 38
  deleting 42
  description of 37
  editing 42
  tips for creating 38
vocabulary pane 6

W
workflow
  assign participant 98
  participants 98
  release task 100
  remove participant 100
  start 91
  tasks 92
  terminate 100
Workflow 91
workflow participant
  assign 98
  remove 100
workflow task
  edit properties 100
  release 100
workflows
  alert notifications 8
  manage 95
  view 97
Gain Greater Insight into Your SAS® Software with SAS Books.

Discover all that you need on your journey to knowledge and empowerment.

support.sas.com/bookstore for additional books and resources.